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Copyrights | Trademark Notices | Licenses
Vlasta Handan - vlastah@telestream.net - attorney responsible for this content. 
Copyright © 2025 Telestream 2, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream 2, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
Pipeline, Sentry, Surveyor, Vantage Cloud, CaptureVU, FlexVU, PRISM, Sentry, Stay 
Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its Affiliates. All 
other trademarks are the property of their respective owners. 

Telestream products are covered by U.S. and foreign patents, issued and pending. 
Information in this publication supersedes that in all previously published material. 
Specifications and price change privileges reserved.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

intoPIX and Fraunhofer. Notice under 35 U.S.C. §287(a): This product or service 
includes JPEG XS compliant features that are covered by patents in the United States 
and in other jurisdictions owned by intoPIX SA (“intoPIX”) and/or Fraunhofer-
Gesellschaft zur Foerderung der angewandten Forschung E.V. (“Fraunhofer”) and listed 
at HYPERLINK http://www.jpegxspool.com. Additional patents may be pending in 
United States and elsewhere.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

Built with Llama. Llama 3.1 and Llama 3.2 are licensed under the Llama Community 
License, Copyright © Meta Platforms, Inc. All Rights Reserved. See https://
www.llama.com/llama3_1/license/ and https://www.llama.com/llama3_2/license/.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.
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MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2016|Server 2019|Server 2022, Windows 10, 
Windows 11, Media Player, Media Encoder, .Net, Internet Explorer, SQL Server 
2012|2016|2019|2022, and Windows Media Technologies are trademarks of Microsoft 
Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.
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VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 



 
Limited Warranty and Disclaimers

5

ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream 2, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.
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Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.
Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.
Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.
Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA
You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Server Regulatory Compliance
EDNOTE For SYS-121H-TNR only: 1/10/25 Updated per SuperMicro 
victor.yuan@supermicro.com
Electromagnetic Emissions: FCC Part 15 Subpart B, ICES-003, EN 55032, EN/BS 55024, 
EN/BS EN 55035, EN 61000-3-2, BS EN 61000-3-2, EN 61000-3-3, BS EN 61000-3-3,  VCCI-
CISPR 32, AS/NZS CISPR 32
Electromagnetic Immunity: EN 55035
Safety: IEC 62368-1, EN 62368-1, CSA C22.2 No. 62368-1-14, UL 62368-1
Additional Country Certifications: NOM, IRAM S-Mark
California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.
Contact Telestream Customer Service for additional Regulatory Compliance certificates.
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Contacting Telestream

Resource Contact Information

Vantage Technical 
Support

Web Site: telestream.net/
telestream-support/vantage/support.htm
Support Email: support@telestream.net
Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Vantage Information, 
Assistance, FAQs, 
Forums, & Upgrades

Web Site: telestream.net/telestream-support/vantage/
support.htm

Telestream, LLC Web Site: telestream.net
Sales and Marketing Email: info@telestream.net

International 
Distributor Support

Web Site: telestream.net
See the Telestream site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net
If you have comments or suggestions about improving this 
document, or other Telestream documents—or if you've 
discovered an error or omission, please email us.

https://telestream.net/telestream-support/vantage/support.htm
https://telestream.net/telestream-support/vantage/support.htm
mailto:support@telestream.net
https://telestream.net/telestream-support/vantage/support.htm
https://telestream.net/telestream-support/vantage/support.htm
https://telestream.net
mailto:info@telestream.net
https://telestream.net
mailto:techwriter@telestream.net
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Vantage Cloud Overview
This chapter presents an overview of Vantage Cloud, a service hosted on Telestream 
Cloud—its features, components, and typical applications—to help you get started, 
and understand how you can use Vantage Cloud services in your Vantage domain.

This document applies to the current or later version of Vantage identified in the title, 
unless superseded by a newer publication. You should use the latest publication for 
your version of Vantage. Visit telestream.net/telestream-support/vantage/support.htm 
to view or download current publications.

Note: This guide frequently refers to Telestream Cloud as well as Vantage Cloud. 
Telestream Cloud is a cloud-based platform providing media-focused services. It 
includes Vantage Cloud, a workflow-driven media processing service hosted on 
Telestream Cloud.

Topics
 Getting Started
 Understanding Types of Vantage Workflows
 Extending a Vantage Domain to Telestream Cloud
 Prerequisites
 Vantage Cloud Workflow Pricing
 Monitoring Billing in Telestream Cloud
 Managing Telestream Cloud Accounts and Assets
 Canceling a Telestream Cloud Account

Note: This guide is written for video professionals who are familiar with using 
Vantage, and focuses on creating and using Vantage workflows via Vantage Cloud. All 
other aspects of Vantage management and utilization are described in separate 
Vantage guides. If you aren’t familiar with Vantage, we suggest that you read the 
Vantage Workflow Designer User’s Guide and Vantage Domain Management Guide.

https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/8-2/Vantage-User-Guide.pdf
https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/8-2/Vantage-Domain-Management-Guide.pdf
https://telestream.net/telestream-support/vantage/support.htm
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Getting Started
Vantage Cloud expands the power of your Vantage domain to execute workflows that 
include Vantage Cloud services. Whether your domain is a single-node Vantage 
domain or a multi-node Vantage array, with Vantage Cloud, you have access to flexible, 
scalable media processing power in Telestream Cloud.

Before using Vantage Cloud, you should be familiar with:

• Designing and constructing workflows in Workflow Designer, including the role 
and use of variables and media nicknames in workflows

• Decision making and branching workflow execution 

• Vantage Secured Version Control—read Using Vantage Secured Version Control, 
published on the Telestream web site.

Topics
 Overview

 Typical Vantage Cloud Applications

 Ideal Use Cases for Hosted Workflows

 Use Cases Not Well-suited for Vantage Cloud Workflows

Overview
Vantage Cloud is a set of features that enables—and interfaces with—Vantage services 
that are hosted in Telestream Cloud—and executed by cloud-capable actions in cloud-
capable workflows. These actions enable Vantage domains to leverage additional cloud 
processing on demand. Whenever workload peaks or other requirements demand it, 
using Vantage Cloud to extend your domain to cloud-based media processing only 
requires a few changes to a Vantage domain and your workflows.

Here are the key features and benefits of using Vantage Cloud:

• Works in new or upgraded Vantage domains for workflow creation and execution

• Deploys action execution to Vantage Cloud using containerized micro-services 
with functionality identical to the on-premise edition of the services

• Enables seamless execution of Vantage workflows wherever required. Cloud-capa-
ble actions can run on-premise or in Vantage Cloud, and workflows can be designed to 
shift processing to the cloud automatically when workload exceeds a threshold.

• Workflows can be deployed on-premise or in Vantage Cloud

• Enables easy modification of existing workflows to run in Vantage Cloud

• Enables easy startup and scaling of additional cloud-based Vantage resources

• Provides additional cloud processing power on demand economically.

https://www.telestream.net/pdfs/app-notes/app-Secured-Version-Control.pdf
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Typical Vantage Cloud Applications
Vantage Cloud workflows (hybrid and hosted) are ideally suited for Vantage users who...

• Want to leverage new or existing on-premise Vantage domains and workflows

• Need to respond quickly to rapid changes in demand for Vantage processing

• Want to save money and time by accessing Vantage Software as a Service (SaaS) 
instead of investing in additional on-premise hardware to meet peak demands

• Want occasional access to specialized features without requiring a license

• Want the simplicity of cloud processing that “just works” whenever you need it.

Ideal Use Cases for Hosted Workflows
Hosted Workflows—workflows specifically designed for hosting and execution directly 
in Vantage Cloud, are ideally suited for Vantage users who...

• Have media located on cloud storage (Amazon S3, Google Cloud Storage, Azure 
BLOB storage). Maintaining files in the cloud typically is not a significant opera-
tional cost. Greater costs typically arise when you move files out of the cloud. Con-
sider designing your workflows so as to minimize the number (or frequency) of files 
that are downloaded.

• Primarily want to submit cloud-resident media for cloud processing via a third 
party program or system via an API.

• Have materially variable workload—for example, on most days you typically 
transcode a few hundred files; but each Thursday, you typically transcode about 
1500 files for weekend consumption.

• Require dynamic scalability: efficient, concurrent processing high volumes of jobs 
is critical to your operation.

• Value total throughput over total transcoding time per job. For example, you need 
to transcode about a thousand files as a batch (potentially concurrently), but it isn’t 
important that it takes 15 minutes longer per file, for example.

Use Cases Not Well-suited for Vantage Cloud Workflows
It is equally important to understand the scenarios which may not be beneficial to 
migrating from a Vantage on-premises workflow to a Vantage Cloud hybrid or hosted 
workflow.

Vantage Cloud workflows are not recommended for users who...

• Are processing on-premises repositories of extremely large or highly-dense media 
files. The time and cost of uploading these to cloud storage may be prohibitive or 
offset the potential savings of cloud processing.

• Are downloading high volumes of transcoded media back on-premises—Vantage 
Cloud workflows may not be ideal due to the egress costs/fees incurred.

• Require high throughput of individual jobs—that is, highest possible entire work-
flow execution speed and fastest turn-around time. Vantage Cloud workflows typi-
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cally will not match the speed that is enjoyed by GPU acceleration on a Vantage 
Lightspeed server. If you are required to process a particular asset in a fixed amount 
of time, these workflows may not be the best option when compared to processing 
the asset in an on-premises Vantage domain hosted on Lightspeed servers.

• Workflows which require interaction/inter-operation with fixed assets may not be 
candidates for Telestream Cloud hosted workflows (for example, if a workflow inte-
grates or is tightly coupled with an on-premises Watermarking service).

• Submitting jobs the way you typically submit jobs on-premises: work orders, hot-
folder ingests of local, on-premises media, drag, drop, and forget jobs, and jobs 
submitted via Vantage TrafficManager or other Workflow Portal applications.

• Transcoding extremely large or 4K and higher format files which reside on-prem-
ise—the cost of uploading the file to the cloud may be prohibitive.

• Delivering transcoded media back on-premise—egress costs may be prohibitive.

• Individual job throughput—transcoding each job as quickly as possible is critical

• Have applications that require operator intervention. For example, paired work-
flows with an operator using Workflow Portal to view/trim/update metadata before 
submitting the media for final processing.
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Understanding Types of Vantage Workflows
Vantage Cloud expands the scope of a Vantage domain to include Telestream Cloud, 
and—in addition to default, on-premises workflows—enables you to create two 
additional, different types workflows—hybrid workflows and hosted workflows. All 
workflows, regardless of type, are designed in Workflow Designer. Some actions that 
you may include in a workflow require a specific license.

Topics
 Hybrid Workflows

 Hosted Workflows

Hybrid Workflows
Hybrid workflows are workflows that execute directly in your on-premise Vantage 
domain and managed in Workflow Designer, but include one or more actions that can 
execute in Telestream Cloud at run time.

Telestream 
Cloud

Vantage Engine Containers Vantage Engine Cloud Execution

Control & Status

Control 
& Status

Media
Cloud Storage 

S3 / Blob

Vantage 
Domain

Vantage EngineAPI
Integration

On-Prem Storage

Post 
Producer

Flip64 IPTV Timed 
Text Flip

Analysis
Multi-
screen

In addition to Vantage actions in hybrid workflows that only execute on-premise, these 
workflows include cloud-capable actions, which may execute in Telestream Cloud 
when in Cloud mode. They may also include Location Action | Cloud Speech Action, 
which only execute projects implemented in Vantage Cloud. 

For information on creating and using hybrid workflows, see Creating Hybrid Workflows.
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Hosted Workflows
Hosted workflows are intended for hosting and execution directly in Telestream Cloud, 
without any dependencies on Vantage after the creation and configuration phase. Only 
certain media processing actions (see Using Vantage Cloud-capable Media Processing 
Actions) can be utilized in hosted workflows, and the execution of these actions is 
governed by your Vantage Cloud service contract and billing system.

Note: Before you can execute hosted workflows in Telestream Cloud, a Telestream 
Cloud account is required with an active Telestream Cloud service, and a cloud storage 
account, registered for utilization in Telestream Cloud (See Vantage Cloud 
Requirements). 

Hosted workflows enable you to expand your on-premises Vantage solutions into 
intelligent, cloud-native media transformation engines. You design these powerful, 
automated workflows using Vantage Workflow Designer, and then deploy them to 
Telestream Cloud (directly from Workflow Designer—see Managing Hosted Workflows) 
where you can access and execute them from anywhere in the world. 

Decentralized access to your own cloud-based media processing applications with no 
single point of failure changes the game, expanding horizons for your media 
processing requirements.
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Cloud

Vantage Engine Containers Vantage Engine Cloud Execution Media

API
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S3 / Blob

Hosted Workflow
Repository
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         &
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Orchestration
Container
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Control &
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Control &
Status

Watcher

Vantage Domain
Database
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Hosted workflows are a subset of hybrid workflows, where the supported set of utility 
actions supported is limited. See Using Vantage Cloud-capable General-Purpose Actions.

Once you have delivered a workflow to Telestream Cloud; the on-premise Vantage 
domain is only required to modify or update the workflow or create new ones.

Unlike hybrid workflows, hosted workflows are managed using the Telestream Cloud 
console.
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Jobs are typically submitted via a Vantage Cloud API-based client program or system. 
They may also be submitted via the Telestream Cloud console.

Action execution occurs exclusively in Telestream Cloud. These workflows can only be 
comprised of cloud-capable actions, which all execute in Telestream Cloud. Hosted 
workflows can not include these cloud actions: Cloud Speech | Location.

For details on creating and using hosted workflows, see Creating Hosted Workflows.

Extending a Vantage Domain to Telestream Cloud
With the advent of Vantage Cloud, the concept of a Vantage domain expands to 
include all Telestream Cloud components that inter-operate with an on-premise 
Vantage domain. 

• Hybrid and hosted workflows interact with Telestream Cloud to provide seamless 
media processing and data storage provided by supported cloud storage vendors. 

• When Cloud-capable actions are in Cloud mode, they display pricing per content 
minute and per file. When these actions execute in Telestream Cloud, you are 
charged for execution by the content minute.

• Workflows can be enabled to determine automatically whether to execute locally 
or in Vantage Cloud—based on your media location and domain utilization (work-
load).

• Vantage displays processing status for both on-premise and Cloud-based actions.

Telestream Cloud Processes and Features
• Telestream Cloud hosts version-matched Vantage services to execute these actions: 

– Analysis

– Conform

– Flip64

– IPTV Flip

– Multiscreen Flip

– Tempo

– Timed Text Conform

– Timed Text Flip

• Media can be stored on-premises or in supported third-party cloud storage: Ama-
zon AWS, Microsoft Azure, and Google Cloud Storage. 

• Media that is already in the cloud, stays in the cloud. Local (on-premise) media is 
transferred automatically to the cloud for Cloud-based processing.

• When activated by a workflow, Telestream Cloud rapidly spins up a Vantage Engine 
Container and processes the media in the Cloud.

• Many jobs process simultaneously, based on dynamic Telestream Cloud scaling.



Vantage Cloud Overview
Prerequisites

20 
Prerequisites
Before you start designing Vantage Cloud hosted workflows in Vantage and deploying 
them to Telestream Cloud, make sure that you have met these prerequisites:

• Vantage 8.3 or later. A Vantage domain where hosted workflows are created and 
configured requires all Vantage services to installed and running.

• Your on-premises Vantage domain must be kept up to date with the latest Compo-
nentPacs. Vantage Cloud utilizes the ComponentPac revision of each Vantage 
Cloud-capable action in a workflow to determine which version of the Telestream 
Cloud service to use when it executes the job in Telestream Cloud.

• A Telestream Cloud account is required to utilize Vantage Cloud. If you don’t have 
one, in Chrome, go to cloud.telestream.net to create a a free trial account. 

• A cloud storage account is required to use any feature of Telestream Cloud. If you 
don’t have an account with one of these cloud storage providers: Amazon S3 | Goo-
gle Cloud | Microsoft Azure, create one and become familiar with using it.

Note: See Getting Vantage Cloud Up and Running for a comprehensive description of 
all Vantage domain and Telestream Cloud requirements and configuration. You’ll also 
learn how to create cloud storage and a Telestream Cloud account and register them 
in Vantage and Telestream Cloud so that they can be accessed and utilized during 
workflow execution.

Vantage Cloud Workflow Pricing
Pricing is per-action for Cloud-capable actions—those that process media essences 
directly (see Using Vantage Cloud-capable Media Processing Actions). Prices are displayed 
on a per minute and per file basis on actions in Workflow Designer workflows and are 
based on pre-discount list prices:

 

Estimated pricing, per 
minute and per file

These prices are only approximate and should not be used to calculate actual fees. 
Prices for data transfers are not included in these usage fees, which if applicable, will be 
charged by your cloud storage provider separately from Telestream Cloud usage fees.

https://cloud.telestream.net/
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Note: Telestream may change its prices at any time without prior notice. When 
multiple outputs are produced by a single action, actual charges for this action are 
based on the largest output produced by this action. When variables have been 
bound to fields such as width and height, the calculated prices displayed in Vantage 
are based on the default value of the variable.

A number of factors affect pricing. For example, these are some Flip64 pricing factors:

• Video Compressor or direct-conversion

– Height, width, frame rate

– Multi-pass encoding

– Custom interlacing rules

• Certain output packagers incur an additional charge.

• Dolby encoding and decoding incurs an additional charge. (Dolby AC-3 decoding 
pricing does not display on the action; it is determined at runtime.)

See Monitoring Billing in Telestream Cloud for details on viewing Telestream Cloud 
billing.

Monitoring Billing in Telestream Cloud
Users who have Vantage Cloud access in Telestream Cloud can view usage and billing:

1. Log into Telestream Cloud with your credentials to display the dashboard.

2. In the dashboard, go to Vantage Cloud—click on Go to service.

3. In the menu, display the Analytics page. The Analytics page displays your usage for 
the specified time period and provides data filtering.

4. To view approximate charges, select one or more workflows or actions and a date 
range, and click Apply Filters.



Vantage Cloud Overview
Managing Telestream Cloud Accounts and Assets

22 
5. Telestream Cloud displays the charges for the workflows/actions and date range 
selected:

Note: This page is not a bill; it displays the approximate charges incurred to date. You 
will receive a separate monthly bill or a credit card charge from Telestream.

For additional information about how Vantage Cloud pricing is determined based on 
workflow execution, see Vantage Cloud Workflow Pricing. If you have any questions or 
need additional details about billing, please see Canceling a Telestream Cloud Account.

Managing Telestream Cloud Accounts and Assets
A Telestream Cloud account is required to utilize Vantage Cloud. When you are ready to 
establish your Telestream Cloud account, in Chrome, go to cloud.telestream.net and 
start your free trial account.

https://cloud.telestream.net/
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ednote obsolete

To learn how to establish a Telestream Cloud account, see Creating Your Telestream 
Cloud Account. 

Canceling a Telestream Cloud Account
To cancel your Telestream Cloud account and discontinue billing, please contact 
Vantage Technical Support—see Contacting Telestream.



Vantage Cloud Overview
Canceling a Telestream Cloud Account

24 



Getting Vantage Cloud Up and Running 
Vantage Cloud Requirements

27
Getting Vantage Cloud Up 
and Running

This chapter focuses on meeting Vantage Cloud requirements, creating a cloud storage 
account and a Telestream Cloud account, and configuring Vantage and Telestream 
Cloud to utilize Vantage Cloud—all the tasks required to get Vantage Cloud up and 
running after you’ve installed and/or updated your Vantage domain.

Note: Vantage installation/updating is not described in this guide. For full details, see 
the Vantage Domain Management Guide on the Telestream web site.
To make best use of Vantage Cloud, you should frequently check for new Update Pack 
and ComponentPac releases and update your Vantage domain to utilize the 
functionality that is provided, which may lift some restrictions (see Configuration 
Limitations in Vantage Cloud Mode).

Topics
 Vantage Cloud Requirements
 Creating a Cloud Storage Account
 Creating Your Telestream Cloud Account
 Configuring Vantage for Vantage Cloud

Vantage Cloud Requirements
These are the accounts, services, and products you’ll need in order to implement a 
Vantage Cloud-enabled Vantage domain and use it to process your media.

Note: Your Vantage domain should have high-speed Internet access (not dial-up or 
satellite) in order to utilize Vantage Cloud and Telestream Cloud.

Topics
 Third Party Cloud Storage Account

 Telestream Cloud Account

 Vantage Domain

https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
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Third Party Cloud Storage Account
Vantage Cloud uses your third-party cloud storage account for accessing your media 
and storing processed output files. You will need an account on Amazon AWS, Google 
Cloud Storage, or Microsoft Azure. (See Creating a Cloud Storage Account.) 

Telestream Cloud Account
Establish an account in Telestream Cloud (https://cloud.telestream.net)— (see Creating 
Your Telestream Cloud Account). To create this account you’ll need your cloud storage 
account information, so create your cloud storage account (immediately preceding) 
first if you haven’t already done so.

In your new Telestream Cloud account, you should enter your third party cloud storage 
account and credentials, so that Vantage Cloud can access your cloud storage.

Vantage Domain
You can execute Vantage Cloud-capable actions in Telestream Cloud from a single-
node Vantage domain or array. For Vantage platform requirements, see the Vantage 
Domain Management Guide. 

EDNOTE Review - don’t think this is true:Using Vantage Cloud on a single-node domain 
requires a Vantage Cloud Designer license (V-SW-VANTAGE-START) or any other license 
which allows workflow design and activation, such as Transcode (V-XCODE-SW) or 
higher. Actions in Cloud mode are licensed for per-minute | per file Cloud execution. 

Note: The Utilization action, used to manage workload between the Cloud and on-
premise actions, requires a Vantage Array Pro license.

For software and licenses, visit www.telestream.net and choose Vantage from the Buy 
menu. 

Creating a Cloud Storage Account
A third-party cloud storage account is required to use Vantage Cloud. Vantage Cloud 
supports Amazon AWS, Google Cloud Storage, Microsoft Azure and other providers.

See the instructions for a summary of how to set up an account with the supported 
vendor of your choice. If you require further assistance, refer to the documentation on 
the vendor’s web site. Instructions are also summarized on the Telestream Cloud site 
storage page.

Topics
 Cloud Storage Considerations

 Creating an Amazon AWS Account

 Creating a Google Cloud Account

 Creating a Microsoft Azure Account

https://cloud.telestream.net
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/VantageDomainManagement.pdf
http://www.telestream.net/
https://docs.telestream.dev/docs/user-guides-storage
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Cloud Storage Considerations
• Performance may vary by the type of storage resource you choose. Network traffic 

during busy times may affect storage performance and transfer speeds.

• Virtual servers can become temporarily unavailable. If Vantage Cloud has trouble 
accessing your storage, visit your storage site to determine whether your storage is 
inaccessible for some reason. Be sure to verify your credentials.

• Default storage account settings specify limits on various resources. If you bump up 
against the limits and need greater speed or additional storage, contact your stor-
age provider for assistance.

• Normally, Cloud-capable actions automatically transfer source media for process-
ing up to a target cloud storage bucket. The files are placed into the vcp-uploads 
folder in your output storage bucket. However, when using Post Producer CML files 
or other reference sources such as IMF and using a storage bucket for input source 
material, you should identify the specific source input bucket used in Telestream 
Cloud, so that Vantage and Telestream Cloud know where to find the input media 
files being referenced.

Creating an Amazon AWS Account
Follow these steps to create an Amazon storage account:

1. Go to https://aws.amazon.com and follow the instructions in Sign Up.

2. Once your AWS account has been created, go to Amazon Simple Storage Service 
(S3) in the management console and sign up for the service.

3. Go to IAM Users settings (Services > IAM > Users) to create a Telestream Cloud user.

4. Copy the generated user credentials (Access Key ID and Secret Access Key). You’ll 
need these later to configure Vantage Cloud in Telestream Cloud.

5. Read Cloud Storage Considerations below and continue on to Creating Your 
Telestream Cloud Account to enter your credentials to access your storage.

Creating a Google Cloud Account
Follow these steps to create a Google Cloud Storage account:

1. Go to the Google Console (https://console.cloud.google.com/) and follow the sign-
up instructions to create a new account.

2. After signing into your new account, create a GCS project.

3. In the project, select APIs & AUTH in the left sidebar.

4. In the APIs list, click the button next to Google Cloud Storage to turn GCS on.

5. In the project Settings click Enable billing and follow the steps.

https://aws.amazon.com
https://console.cloud.google.com/
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6. Obtain and copy your Access Key & Secret Access Key as follows:

a. Go to your project’s Storage page.
b. Under Cloud Storage select Storage access from the left menu.
c. Click the Interoperability tab on top. You may need to click the Enable 

Interoperability access button to enable the tab. 
d. On the Interoperability tab, find and copy your Access Key & Secret Access Key.

7. Read Cloud Storage Considerations and then continue on to Creating Your Telestream 
Cloud Account, where you will enter your credentials to access your storage.

Creating a Microsoft Azure Account
Follow these steps to create a Microsoft Azure storage account:

1. Go to https://azure.com and click the green Start Free button and follow the 
prompts to create a new account. 

2. After logging into the Azure Portal, click Storage Accounts.

3. Click Add to begin creating a new storage account.

4. Click Create Storage Account and make entries and selections in required fields.

5. Click Review + Create, and verify your selections are correct and validated.

6. Click Create. You will receive a deployment complete message.

7. Select your storage account > Overview > Access Keys.

8. Copy your access keys for use in setting up your Telestream Cloud account.

9. Read Cloud Storage Considerations below and then continue on to Creating Your 
Telestream Cloud Account, where you’ll enter the credentials to access your storage.

Creating Your Telestream Cloud Account
To use Vantage Cloud features in your Vantage domain, you create a Telestream Cloud 
account with Vantage Cloud access enabled. This is where your Cloud-based media 
processing executes. If you have an existing account, you can use it without creating a 
new one.

Note: Before you sign up for an account, you should have a third-party storage 
account that you want your Telestream Cloud account to access for storage. See the 
details in Creating a Cloud Storage Account to create a storage account.

Topics
 Cloud Account Prerequisites

 Creating a Telestream Cloud Account

https://azure.com
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Cloud Account Prerequisites
These prerequisites apply to setting up a Telestream Cloud account:

• A high speed, terrestrial Internet connection to your Vantage server and to the 
computer used to create your Telestream Cloud account.

• An Internet browser for signing up and using Telestream Cloud.

• A third-party Cloud storage account with Amazon AWS | Microsoft Azure | Google 
Cloud Storage.

Creating a Telestream Cloud Account
EDNOTE Every screen shot in this topic is obsolete - update when process is known

1. Point your browser to https://cloud.telestream.net to display this page:

Click Log In to create or use 
your account.

https://cloud.telestream.net
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2. In the upper right corner, click Log in and select Cloud Services to display the login 
page.

Click Create Account to 
create a new Telestream 
Cloud account.

3. On the Sign In page, click Create Account at the bottom, below the Next button.

4. On the Sign Up page, fill out the form and click Sign Up.

Telestream Cloud displays the Dashboard page.

5. Click Get Started in the upper right corner and Telestream will send you an email to 
verify your account.  ednote is this system driven or is there human intervention? 
Time to receive email? continue editing from here

6. When you receive the email, open it and click the link to verify your account.

7. Telestream Cloud displays the Dashboard—click the Get Started button.

Telestream Cloud displays the Free Trial page:

8. On this page, you can activate a free trial or select a billing method.
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9. Click Activate Free Trial. 

Telestream Cloud displays the Dashboard again, with a notice that you have a 7 day 
free trial: EDNOTE UPDTE SCR SHOT

10. In the main menu in the upper right corner, select IAM.
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11. The IAM page displays your keys, including the API Key under Legacy API Access. If 
you have multiple users, you can create multiple keys, one for each user, using the 
Add API Key button.

Note these keys for use in configuring Vantage.

12. In the main menu, select Manage Stores to open the Data Store page.

13. On the Data Store page, click +Add Store to display the Add New Store page.
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14. On the left side of the page, select the type of store you plan to use with Vantage 
Cloud (Google, AWS, etc.).

Note: You must grant some form of Cloud storage access so that Telestream Cloud 
can read and write media and other files to and from your storage.

15. Fill in your store account information so that Vantage Cloud can access your 
account to read and write files. The information fields requested vary depending on 
the selected store. For information about a field, hover over the blue  icon.

16. Click Add Store to complete storage setup.

Vantage Cloud configuration in Telestream Cloud is complete. Go to the next topic to 
configure Vantage and create workflows.
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Configuring Vantage for Vantage Cloud
Before you can create or use Cloud workflows, you must have an operational Vantage 
domain installed or updated to Vantage 8.3 or later. You must also add your Telestream 
Cloud account to Vantage, so it can integrate with Vantage Cloud, and add your Cloud 
storage account to Vantage, so that it can read and write in it.

Topics
 Vantage Installation and Licensing

 Adding your Telestream Cloud Account to Vantage

 Adding your Cloud Storage Account to the Vantage Folder Address Book

Vantage Installation and Licensing
To install/update Vantage and verify it meets Vantage Cloud requirements including 
licensing, follow these steps:

1. If you haven’t yet installed Vantage and licensed it, install and license it now, so that 
you can configure it for Vantage Cloud operation. Install or upgrade to a licensed 
Vantage 8.3 or later installation as explained in the Vantage Domain Management 
Guide. You may have an all-in-one domain, an array, or a Vantage Cloud Designer 
domain.

During installation | upgrade, ensure that the Vantage domain includes the Van-
tage Telestream Cloud Service, all services corresponding to the Vantage Cloud-
capable actions, and the latest ComponentPacs.

These Vantage services are required for Vantage Cloud. Be sure each is selected 
(checked) for installation when you run the Vantage installer:

– Vantage Telestream Cloud Service

– Vantage Transcode Service

– Vantage Timed Text Service

– Vantage Analysis Service

– Vantage Multiscreen Service

– Vantage IPTV VOD Transcode Service

– Vantage Edit Service

Note: In a Vantage array, each node that has the Vantage Telestream Cloud Service 
and at least one other Vantage service which also installs a ComponentPac (such as 
the Vantage Transcode Service) can processes Telestream Cloud jobs.

2. Verify that all the services are running (Online) in the Vantage Management 
Console > Services. If not, right-click and select Restart Service. 

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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Note: While examining the Vantage Services in the Vantage Management Console, 
pay particular attention to the Vantage Telestream Cloud Service Setup.

Note: The Vantage Telestream Cloud Service includes an upload limit that throttles 
concurrent cloud file uploads to prevent overloading your Cloud storage. The default 
is four concurrent files. You can set the service to maintenance mode and then display 
the Cloud service Setup tab to change the Upload Limit value.
The Vantage Telestream Cloud Service also has unique session limit requirements. It 
should be set equal to the number of concurrent jobs allowed for Vantage Cloud. For 
example, if your account is set to a limit of 30 jobs (the default) and the Vantage 
domain consists of 2 nodes, the session limits of the Telestream Cloud service in each 
Vantage array node should be set to 15. 
If the Telestream Cloud service is set to a session limit higher than the capacity of the 
Telestream Cloud account, the jobs will be shown as in process in Vantage and queued 
in Telestream Cloud. If you need a higher concurrent jobs limit, contact Telestream 
Customer Service and request an increase. 

3. If you don’t have license (not required for a Vantage Cloud Designer domain), 
contact Telestream Sales for licensing and install the license as explained in the 
Vantage Domain Management Guide.

Adding your Telestream Cloud Account to Vantage
Follow these steps to add your Telestream Cloud account to Vantage:

1. In the Vantage Management Console > Settings & Options > Cloud tab.

2. Click the yellow key icon to add a new Telestream Cloud account.

3. Enter a name (such as the authorized user name) for the Telestream Cloud account. 

4. Enter the Telestream Cloud API Key you noted previously on the Telestream Cloud 
IAM page (see Creating a Telestream Cloud Account).

https://www.telestream.net/purchase/store.htm
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5. Click Test to make sure that your Cloud account is accessible by Vantage.

6. Dismiss the Success dialog.

Adding your Cloud Storage Account to the Vantage Folder 
Address Book

In order for Vantage and Telestream Cloud to inter-operate with your cloud storage, the 
storage location and credentials must be entered into Telestream Cloud > Cloud Store 
and in the Vantage Folder Address Book. If you use more than one Cloud storage site, 
make a separate entry for each in Telestream Cloud and in the address book.

Additional Notes on the Vantage Folder Address Book
When you set an action to operate in Cloud mode, you specify which Cloud storage 
account to use. Vantage will automatically access the address book entry instead of 
using a local Vantage Store. The cloud storage location is used for copying the source 
file to the cloud prior to processing and for storing output files after processing.

The Vantage Folder Address Book is used by Vantage Cloud to ensure URL compatibility 
between Telestream Cloud and Vantage. When Vantage Cloud places material in cloud 
storage, it refers to the material using a signed URL, which is typically a secure HTTP link 
that expires within 24 hours. These references must be translated to a URL to allow 
downstream Vantage actions to perform all of the required file system operations on 
the media reference. 

The Vantage Folder Address Book entry enables this translation for actions operating in 
Cloud mode. Without the Vantage Folder Address Book entry and associated 
translation, the interaction among Vantage, Vantage Cloud, and cloud storage may not 
work.

To add your cloud storage to the Vantage Folder Address book, follow these steps:
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1. In the Vantage Management Console, select Storage > Vantage Folder Address 
Book.

2. Click the Add Folder icon .

3. Enter the folder exactly the same name as the name you used for your cloud 
storage in your Telestream Cloud account Data Store.

4. Click Modify... to specify the location.

5. Select the type of cloud storage (file system) from the Folder Location Editor 
window.

6. Enter your cloud storage account information, such as access keys | bucket name.



Getting Vantage Cloud Up and Running
Configuring Vantage for Vantage Cloud

40 
Note: The credentials used in the Vantage address book entry MUST exactly match 
the credentials used to access your third-party storage location and the credentials 
used in Telestream Cloud > Cloud Store for that storage location. For example, for S3, 
you must use the same Access Key ID, the same Secret Access Key, and the same 
bucket reference in all three locations. If there is a credential mismatch in any of these 
locations, Vantage Cloud will not work.

7. Enter the folder location on the Cloud server. Your default location is already noted, 
or you can browse or enter a UNC path to another folder.

8. Click Finish to complete the address book entry.
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Designing Vantage Cloud 
Workflows
This chapter explains how to design Vantage Cloud workflows. In Vantage Cloud 
workflows, you can use Vantage Cloud-capable actions. You can create both hybrid 
workflows—which includes on-prem and cloud actions—and cloud-exclusive, hosted 
workflows.

Topics
 Designing Hosted Workflows
 Using Cloud-capable Media Processing Actions
 Using Cloud-capable General-Purpose Actions
 Using Variables and Parameters in Vantage Cloud Workflows
 Creating Hybrid Workflows
 Creating Hosted Workflows
 Troubleshooting

Designing Hosted Workflows
Cloud-hosted workflows—like all workflows—are created directly in Vantage Workflow 
Designer, in your Vantage domain. However, unlike on-prem workflows or hybrid 
workflows, you may also install a Vantage Cloud Designer domain, where the sole 
purpose is to utilize Vantage Workflow Designer to design and manage your Cloud 
hosted workflows—no additional license is required. For details, see the Vantage Cloud 
User Guide, published on the Telestream web site.

Using Cloud-capable Media Processing Actions
Vantage Cloud-capable actions are transcoding or other media processing actions that 
are implemented to execute in Telestream Cloud in the same manner as they do in a 
Vantage domain. Due to cloud platform constraints, there are some limits when 
configured to execute in Cloud mode.

https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-Cloud-Port-User-Guide.pdf
https://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-Cloud-Port-User-Guide.pdf
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Note: If you modify workflows that were created in a version of Vantage that is not 
capable of—or licensed for—Vantage Cloud and Telestream Cloud, you will be 
reminded to upgrade the action first, when you try to enable Cloud mode. To upgrade 
all of your workflows and actions at once, in Workflow Designer select File > Batch 
Workflow Operations > Check for Upgrades, and then select Upgrade.

Vantage services that implement Cloud-capable actions are configured in the Vantage 
Management Console > Services panel > Setup tab. In particular, the Vantage 
Telestream Cloud Service upload limit controls the number of concurrent cloud file 
uploads and the total of this number for all nodes should be set to match the 
concurrent job limit set by Vantage Cloud (30 is the default).

Vantage Cloud tracks source files that have been uploaded for Cloud-capable actions to 
prevent the same file from being uploaded multiple times. 

For example...

• If you have a file at a given location, such as D:\Folder1\foo.mpg, and you sub-
mit this file to a workflow twice, the file will only be uploaded once.

• If the file is deleted from cloud storage and it is submitted again, it will be uploaded 
a second time.

• If the file is submitted to a workflow that targets a different cloud store, the file will 
be uploaded to the second store.

• If you submit a file from a different location (for example, D:\Folder2\foo.mpg), 
the file is uploaded again.

To upload the same file for each job, use a Copy action in the workflow preceding the 
Cloud-capable action, for example: Receive > Copy (to a specific bucket) > Flip64 (same 
bucket).

 Configuration Limitations in Cloud Mode

 Media Transcoding and Processing Actions

Configuration Limitations in Cloud Mode
During the design phase, once you enable at least one Cloud-capable action to operate 
in cloud mode, each time you save an action or upload the workflow to Telestream 
Cloud (Managing Hosted Workflows), Workflow Designer automatically verifies the 
workflow to operate in Vantage Cloud.

Note: To make best use of Vantage Cloud, you should frequently check for new 
ComponentPac releases and update your Vantage domain to utilize the functionality 
that is provided, which may lift some restrictions.
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If unsupported actions are added to the workflow or an action is configured in a way 
that violates the limits imposed by being a Cloud-capable workflow, Workflow 
Designer displays an error. For example:

These features and configurations are not compatible with Cloud-capable media 
processing actions:

• H264 or H265 presets slower than Medium

• Encoded frame sizes greater than DCI 4K

• Multi-pass encoding

• Camera decoder

• Microsoft Smooth Streaming Packager

• Adobe HTTP Dynamic Streaming Packager

• Analysis action outputs for WebVTT, SCC, and SMPTE 2051 TTML. 

• Analysis of Omneon user data

• VP9 Video encoding

• Advanced Title Processor (Conform action)

• Watermarking: Nielsen, Kantar, Teletrax

• Actions which make use of static resources or reference on-premises resources.

You should ensure that all references to resources are either removed, modified to use 
cloud-hosted resources, or replaced by variables. You should make sure that actions are 
configured in a valid configuration which allows Cloud mode. 

For example, a workflow with a Flip64 action which references a static overlay file 
(D:\MyImages\myfile.png for example), will obviously not execute beyond the 
specific, on-premises environment in which it was built.

Actions which reference specific on-premises locations (for example, a Flip64 action 
configured to write output to a network folder) are also invalid.

• Some containers and formats supported in actions executed on-premise may not 
be available in Cloud mode. If you select a container or format not supported in 
Cloud mode, an error message informs you that it is unavailable.

• Actions in Cloud mode should be configured to use the Multi-core Video Processor.
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Media Transcoding and Processing Actions
The following media processing actions may be executed in an on-premise Vantage 
domain or in Vantage Cloud. You can use these Cloud-capable actions in both hybrid 
and hosted workflows:

• Analyze Action

• Cloud Qualify Action

• Cloud Speech Action

• Conform Action

• DPP Validate Action

• Flip64 Action

• IPTV Flip Action

• Location Action

• Multiscreen Flip Action

• Tempo Action

• Timed Text Conform Action

• Timed Text Flip Action

Cloud-capable media processing actions are charged by the media minute. See 
Vantage Cloud Workflow Pricing for details. 

Note: These descriptions are high level. Some action features executable on-premise 
may not be executable in Vantage Cloud. Workflow Designer displays a message if you 
try to use an action feature that is not implemented in Vantage Cloud. For operational 
and configuration details, see the action’s man page.

Analyze Action
The Analyze action (in the Analysis category) is executed by the Analysis service on-
premises or the Telestream Cloud Service in hosted workflows. It can perform many 
kinds of analysis on media using a variety of analysis tools, and populate variables for 
use downstream. For example, the action can detect black, color levels, interlacing, 
letterbox, slate, scene changes, audio levels, and much more. 

Cloud Qualify Action
The Cloud Qualify action is part of the Cloud group, which is executed by the 
Telestream Cloud service. The Cloud Qualify action processes a media file (identified by 
nickname) in a Qualify project in your account, and returns a report and the result in a 
string variable.
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Cloud Speech Action
The Cloud Speech action is Cloud-capable. It is executed by Telestream Cloud service 
on-premises or the Vantage Telestream Cloud Service in hosted workflows. The Cloud 
Speech action submits media from workflows via the Telestream Cloud Service and the 
Telestream Cloud API to Telestream Cloud for speech-to-text conversion. To use the 
Cloud Speech action you must have a Telestream Cloud account and enter the account 
credentials in the Vantage Management Console to enable Vantage to access the 
account. When the Cloud Speech action executes, the input file is uploaded and 
processed according to the Cloud Timed Text Speech project chosen in the Cloud 
Speech action, and the results are returned to the workflow for downstream use. 

Conform Action
The Post Producer Conform action (in the Edit category) is executed by the Vantage Edit 
service. This action assembles and optionally transcodes multiple video and still image 
files into a single output file, applying filters you specify. The input files and related 
instructions for the output file are all defined in a composition XML file. 

Note: Because of font rendering differences between Windows and Linux, if a Cloud 
mode Conform action’s ingested CML file specifies a text shadow or over-line effect, 
these effects are ignored and are not rendered in the output. Font information 
included in the Timed Text Flip description also applies to fonts specified in CML.

When the Conform action is in Cloud mode, the source CML file may reference media in 
cloud storage only if the following conditions are true:

• The Vantage Folder Address Book must have an entry for the bucket/blob container 
containing the media.

• The Telestream Cloud account must have a store for the bucket/blob container con-
taining the media.

• The CML file must be submitted to the Conform action from a UNC or local Win-
dows path (for example, D:\source.cml or \\server\source.cml). 

The CML may refer to a file in storage by the nickname, short URL, or long URL. 

Example 1 refers to a media file nicknamed Original:

<File location="{$#Original}"/>

Example 2 refers to a media file nicknamed Image: 

<Image layer="1" align="both" adjust="body" location="{$#Image}" 
fill="loop" duration="00:00:02.000">

Example 3 refers to the short URL of a media file in S3 cloud storage. In the third 
example, s3://ts-us-east-2-ohio is an S3 bucket, oes-sources is a folder within the bucket, 
and 1min.mov is the media file name:

<File location="s3://ts-us-east-2-ohio/oes-sources/1min.mov"/>

Example 4 refers to vantageblobstore as the Azure storage account name, ts-cloud-test 
as the blob container name, and 2min.mov as the file name.
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<File location="azure://vantageblobstore.blob.core.windows.net/
2min.mov?containerName=ts-cloud-test"/>

Example 5 refers to ts-vantage as the Google bucket name, and 2min.mov is the file 
name.

<File location="gcs://ts-vantage/2min.mov"/>

Example 6 shows the case where you may need to use the full URL to the file. 

https://accountname.s3.us-west-1.amazonaws.com/FAA_Short 1.mp4?X-
Amz-Algorithm=AWS4-HMAC-SAH256&X-Amz-Content-Sah256=UNSIGNED-
PAYLOAD&X-Amz-Credential=AKIAIYVKOY43MTXXXXXX%2F20190423%2Fus-
west-1%2Fs3%2Faws4_request&X-Amz-Date=20190423T231319Z&X-Amz-
Expires=7200&X-Amz-SignedHeaders=host&X-Amz-
Signature=9bac488f32ab94ffe88c096962f6cdcf2c04845d8a18df0bd4abfe

To view and copy the full URL in Workflow Designer:

1. View the job output that produced the file in Job Status Views.

2. Double-click the job to open the binder. 

3. Right-click the Output. 

4. Select View Full URL.

5. Click in the URL and use Ctrl-A or scroll and highlight to select all. 

6. Right-click Copy to put the URL into the clipboard for pasting to another location. 

Note: If a reference file or CML file that references more than 32 files is submitted to a 
Cloud-capable action, the job will fail at run time, indicating that this is not supported.
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DPP Validate Action
The DPP Validate action is Cloud capable. It is executed by the on-premises or the 
Vantage Telestream Cloud Service in hosted workflows. You can use the DPP Validate 
action to confirm compliance of a DPP metadata XML file. If the XML file passes 
validation, TRUE is generated; otherwise FALSE is generated. You can test the results of 
the action downstream to change the workflow’s actions based on the validation 
results. Optionally, you can also generate a report when executing on-premises.

Flip64 Action
The Flip64 action (in the Transcode category) is executed by the Vantage Transcode 
service and is a 64-bit multi-core-optimized encoder that transcodes media from one 
or more input files into another format as specified by the output configuration. 
Available resolutions extend from SD to UltraHD and 4K in a broad range of file formats. 

IPTV Flip Action
The IPTV Flip action (in the IPTV/VOD category), is executed by the Vantage IPTV VOD 
service. This action is designed to generate MPEG2 Transport Stream files and meet 
multiplexing requirements. The IPTV Flip action and IPTV VOD Service support the 
features required to handle varying IPTV, set-top box and cable encoding requirements, 
and ancillary metadata specific to cable ad splicing and cable/IPTV set-top box 
environments. 

Location Action
The Location action is part of the Cloud group and is executed by the Telestream Cloud 
Service. The Location action enables you to generate Boolean variables that specify 
whether then associated media file (identified by its nickname) is stored in the cloud or 
stored on-premise (any location other than the cloud).

The purpose of the Location action is to provide a value on which a decision can be 
made with regards to the locality of a given file (represented by a nickname). 
Specifically, whether the file exists in an on-premises storage location or whether the 
file exists on a cloud-native storage location. This enable you to create a workflow 
routing pattern that is controlled by the location of the media being processed. 

For example, if the material resides in a cloud-native location (for example, Amazon S3), 
then a Decide action can route the media to a Cloud-enabled Flip64 action for 
transcoding. If the material resides locally, a Decide action can route the media to 
another branch in the workflow and execute a Flip64 action for on-premises 
transcoding.

You can also use the Location action to generate pre-signed URLs for files in cloud or 
object storage. You can use pe-signed URLs to grant Vantage temporary access to files 
on external systems.

Multiscreen Flip Action
The Multiscreen Flip action (in the Multiscreen category) is executed by the Vantage 
Multiscreen Service and is designed for encoding and packaging decoded digital 
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baseband media into industry-standard adaptive rate streaming formats, including 
Adobe HDS, Apple HLS, Microsoft HSS, and others. 

Tempo Action
The Tempo action is part of the Edit group and executed by the Vantage Edit Service. 
The Tempo action is included in Tempo, a time-adjusting encoding solution built on 
the Vantage platform. The Tempo action uses the Edit Service for re-timing file-based 
content and intelligently decreasing or increasing the running time of shows and 
segments. 

Timed Text Conform Action
The Timed Text Conform action (in the Timed Text category) is executed by the Vantage 
Vantage Timed Text service to extract subtitle/caption data from assets referenced in 
CML files and create one or more subtitle/caption files of the specified format, for use 
downstream, in other workflows or other systems.

The Timed Text Conform action automates stitching of caption/subtitle segments 
referenced in a CML file where clips have been cut that cause truncation or overruns. 
The Post Producer Conform action (using the Closed Caption filter) can correctly stitch 
audio and video as specified in the CML file, but caption/subtitles may be truncated or 
run over into subsequent segments, depending on the exact location of start and end 
times. Timed Text Conform is used in these situations to isolate the caption/subtitles 
around a stitch point specified in the CML file, ensuring that no truncation or run over 
into subsequent segments occur. 

You can utilize the common CML file in Vantage workflows with actions that support 
CML as an input format—Post Producer Conform, for example—for stitching the video 
and audio. Outputs from Post Producer Conform and Timed Text Conform are then 
combined into a production media file downstream or in other Vantage workflows, 
using for example, Flip64 or Timed Text Flip configured with Same As Source output. 

Timed Text Flip Action
The Timed Text Flip action (in the Timed Text category) is executed by the Vantage 
Timed Text service to ingest and perform caption file-type conversions, embed 
captions, extract captions from media containing embedded captions, create subtitle 
overlay graphics, and manipulate the timecode of caption data to match media.

Supported Fonts
These fonts may be used with the Timed Text Flip action in Vantage Cloud mode. If you 
select a font that is unavailable in Vantage Cloud mode, you will not be able to enable 
Cloud mode and an error message explains that the selected font is not available.

• Andale_Mono.ttf—Regular, Mono

• Arial.ttf—Regular, Black, Bold, Italic, Bold Italic

• Comic_Sans_MS.ttf—Regular, Bold

• Courier_New.ttf—Regular, Bold, Italic, Bold Italic
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• Georgia.ttf—Regular, Bold, Italic, Bold Italic

• Impact.ttf

• Times_New_Roman.ttf—Regular, Bold, Italic, Bold Italic

• Trebuchet_MS.ttf—Regular, Bold, Italic, Bold Italic

• Verdana.ttf— Regular, Bold, Italic, Bold Italic

• Webdings.ttf

Fonts render differently in Windows vs Linux operating systems. Subtitles or other on-
screen print renderings that use the fonts built into the OS may result in print output 
from the cloud (Linux) that differs from the same output on Windows. In particular, font 
size, font spacing, font effects and anti-aliasing may have subtle differences on the two 
platforms. If you require a specific font style with Vantage Cloud, Telestream 
recommends waiting until NewBlue support is added to Linux.

Using Cloud-capable General-Purpose Actions
A subset of general-purpose/utilitarian Vantage actions are also implemented in 
Vantage Cloud. These actions are supported for hosted workflows—they can execute 
in Vantage Cloud in the same way as they do in an on-premises Vantage domain. There 
is no per-action charge for executing these actions. These actions are not explicitly 
configured to run in Cloud mode; they do not display the Cloud mode badge.

These actions are supported in hosted workflows:

• Compute

• Construct

• Decide

• Extract

• Multi-Decide

• Notify with HTTP Notifier

• Receive

• Synchronize

Note: When you utilize these actions in a hybrid workflow, they automatically 
execute on-premise; in hosted workflows they of course execute in Vantage Cloud. 
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Using Variables and Parameters in Vantage Cloud 
Workflows

Vantage Cloud workflows utilize variables in the same manner as on-premises 
workflows. Workflows that use expected variables—variables that are not created or 
updated internally upstream—can only be used by a job submission method that is 
capable of supplying values for these variables (parameters in the case of API 
submission) at run time.

For hybrid workflows, you can submit jobs from another workflow, a work order, from 
Workflow Portal, or from a third party program using the Vantage API. For hosted 
workflows, you can only submit jobs via an API-based program or system.

Note: Detailed information about parameter binding and variable manipulation is 
provided in the Vantage User Guide and Vantage Rest API Guide.

For example, here is an IPTV/VOD action where the x264 codec’s resolution is being set 
by variables instead of constants:

To view expected variables—variables that are utilized in a workflow but are not set by 
default or set within the workflow, expand the Properties of the workflow panel (using 
the open/close arrow just to the left of the workflow title). 

http://www.telestream.net/pdfs/user-guides/Vantage-UserGuides/Vantage-User-Guide.pdf
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In this case, two variables are expected (these correspond to the two variables which 
were bound to the Width/Height parameters of the IPTV action).

To submit a job to this workflow, the job-submission program must be designed to 
obtain these two values, update variables and submit them with the job request.

Creating Hybrid Workflows
This topic explains how to create and design hybrid workflows in Workflow Designer to 
use Vantage Cloud features as well as on-prem features.

Note: Before you can process media in Telestream Cloud, you must have set up your 
Telestream Cloud account, a third-party cloud storage account, and your Vantage 
domain settings for Vantage Cloud operation as explained previously.

 Hybrid Workflow Restrictions

 Bandwidth and Egress Fee Considerations

 Monitoring Utilization for Effective Hybrid Workflows

 Creating a Prototype Hybrid Workflow

 Verifying and Using Hybrid Workflows

Hybrid Workflow Restrictions
A hybrid workflow is one that contains Cloud-capable media processing actions, but 
remains hosted directly in an on-premises Vantage domain and is managed in 
Workflow Designer. Hybrid workflows have the following characteristics and limits:

• Hybrid workflows—unlike hosted workflows—can start with any origin action.

• In addition to containing Vantage actions that only execute on-premise, a hybrid 
workflow must include at least one Cloud-capable action.

• Cloud-based output files generated from Cloud-capable actions can be operated 
on using Vantage Transport Service actions: Copy | Move | Delete | Deploy.

• Cloud-capable or Telestream Cloud action, and Vantage Cloud mode must be 
enabled.

• Certain configuration limitations apply to Cloud-capable actions. See Configuration 
Limitations in Cloud Mode.

•  Hybrid workflows may include Telestream Cloud actions—Location Action | Cloud 
Speech Action—which always execute projects hosted in Telestream Cloud.

• Files uploaded to cloud storage for transcoding are stored in the vcp-uploads folder 
in your cloud account. This enables you to track uploaded files and delete them 
after you no longer need them. Files in this folder must be managed manually.
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Bandwidth and Egress Fee Considerations
Bandwidth requirements for hybrid workflows should play a role in your workflow 
design considerations. This is due to the fact that the bandwidth required is largely 
dependent on what tasks your hybrid workflows are designed to perform.

Here are some examples:

Processing Cloud-based Media
Workflow jobs for media that resides in the cloud and stores the output in the Cloud 
consumes minimal bandwidth, since no files are uploaded or downloaded—URLs are 
utilized to refer to the Cloud-based media and no files are uploaded or downloaded. In 
this example, a typical high-speed Internet connection (as low as a few Mbps) suffices, 
since the workflow is executing via the API in Telestream Cloud.

Processing On-Premises Media
When a workflow job uploads media to the cloud from an on-prem server—or 
downloads the output to an on-prem server at the end of the job—sufficient 
bandwidth is required to adequately support the file transfer.

The bandwidth requirement is based on the bitrate of the media being transferred and 
the required turnaround time for each job. Typically, many orders of magnitude greater 
bandwidth are required to support these jobs than processing cloud-based jobs.

Effects of Bandwidth on Uploads/Downloads
The bandwidth requirements of your connection are necessarily dictated by the 
metrics of the media you are transferring, commonly measured as bitrate—which is 
influenced by your frame size, frame rate, and codec profile. Generally, a 50Mbps up/
down connection per concurrent job is the minimum recommended bandwidth, 
although actual throughout depends on the file bit rate.

For example, achieving real-time upload/download transfer requires bandwidth equal 
to or greater than the bit rate of the media. Lower bandwidth than the media bit rate 
results in transfer speeds slower than real-time and likewise, higher bandwidth results 
in faster than real-time transfer.

Typical Ingress/Egress Fees
In addition to bandwidth requirements, monthly egress fees are common, based on 
your cloud storage subscription—and these costs may be material. Fees often range 
from free for very low volume, to $0.05 to $0.10 per GB based on volume. Example AWS 
prices are available at https://aws.amazon.com/s3/pricing/.

Monitoring Utilization for Effective Hybrid Workflows
The Vantage Utilization action (in the Common group in Workflow Designer) is an 
optional feature which requires a Vantage Array Pro license. It enables you to determine 
the current utilization of the Vantage domain or transcoding actions and report the 
results in a variable, one for each metric being tested.

https://aws.amazon.com/s3/pricing/
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The variable emitted by the Utilization action represents the percentage of utilization 
for each checked metric. The variable can be used in downstream Decide actions to 
control the flow of work through the workflow. The variable can also be passed out of 
the job was well, for external recording or reporting, for example.

These metrics can be used to determine how to efficiently handle the workload by 
directing the workflow to execute one branch or another, including routing to a branch 
with actions are configured to execute in Vantage Cloud, when on-premise services 
approach saturation

The following figures show Utilization action configuration and an example workflow.

For example, if you want to route IPTV VOD actions based on current resource 
utilization to an on-premise domain server running the IPTV VOD service or to a cloud-
based IPTV VOD resource, you can submit a job to a workflow that executes a 
Utilization action to test the IPTV VOD load. 

If the result is lower than the maximum workload threshold, the workflow can trigger 
the on-premise IPTV VOD action. However, if the load is higher than the threshold, the 
workflow can trigger a cloud-mode-enabled IPTV VOD action that transcodes the 
media in Telestream Cloud. 
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1. When the workflow completes, check Vantage Job Status for success or failure. If 
there is a failure, Vantage Job Status and your Telestream Cloud account provide 
details about what happened.

2. If you have access to the Vantage Cloud account in Telestream Cloud, click 
Dashboard > Vantage Cloud. 

The Jobs Overview displays each job and its status details:
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3. Click the Workflow Name or Vantage Job Name to see details about the job.

4. Finally, check the binder (right-click the job and select View Binder) and the cloud 
storage for expected output files (AWS S3 example shown). 
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Creating a Prototype Hybrid Workflow
To create a hybrid workflow, in Workflow Designer, follow these steps:

1. Create a new workflow. 

2. Include one or more Cloud-capable | Telestream Cloud actions.

Note: The Output Location for a cloud-based media processing action is not used and 
is disabled. The output always is written to a cloud location (specified in Cloud mode).

3. Enable cloud processing for a Cloud-capable action: right-click the action and 
select Cloud Mode > Configure Cloud Mode. 
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4. In the Vantage Cloud Setup dialog, check Enable Vantage Cloud Mode to activate 
cloud execution for this action. Configure the fields:

After media is processed, the output file is pushed to the target cloud storage loca-
tion. To prevent output file names from colliding in the target cloud store, use Spec-
ify subfolder path in storage to specify a unique location.

5. Select your Telestream Cloud account, select your cloud storage, and specify a 
subfolder path, if any, where you want the output file to be stored. Click the menu 
and select any variables to include for automatic subfolder naming. 

6. Click OK to save your entries and close the window.
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Note: For a Cloud-capable action to execute, the required accounts and credentials 
must be correct in all of these locations:

• Telestream Cloud—You must have a valid Vantage Cloud account, and you must 
include correct third-party storage credentials on the Data Store page.

• Third party cloud storage—You must have at least one valid cloud storage account. 

• Vantage Management Console > Settings & Options > Cloud—You must enter the 
name of your Telestream Cloud account and its API key.

• Vantage Management Console > Vantage Folder Address Book—You must enter 
the exact name and keys for your third-party cloud storage accounts.

• Action Vantage Cloud mode—You must select your Telestream Cloud account and 
your cloud storage account from the menus in the Vantage Cloud Setup dialog.

Verify your credentials carefully in all places. If credentials are entered incorrectly in any 
of these locations, Vantage Cloud may not function properly. 

To review your cloud storage and Telestream Cloud configurations, see Creating a Cloud 
Storage Account and Creating a Telestream Cloud Account.

To review your Vantage settings, see Adding your Telestream Cloud Account to Vantage 
and Adding your Cloud Storage Account to the Vantage Folder Address Book for details.

When Cloud mode is enabled, the Cloud-enabled action shows a Cloud mode badge 
and the price per minute and per file. (Actions in Cloud mode are billed on output 
media duration, except for Analyze, which is billed on source media duration.)

Vantage Cloud 
mode

Price indicator

This example is simplified to present just the basics of Vantage Cloud workflows. 
However, these workflows can be as complex as you need, including analysis, decision-
making, and branching. You can include any action or number of actions downstream 
of the Cloud-capable action. For example, you can use a Copy action to localize a 
transcoded file out of the Cloud, or use a Deploy action to send the file to another 
server or storage location. Because Vantage tracks file locations based on nicknames, 
subsequent actions only require the nicknames to find and process cloud files. 
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Verifying and Using Hybrid Workflows
When workflow design is complete, follow these steps to verify operation:

1. Activate the workflow, submit a job, and monitor the job in the Job Status tab. 

2. Vantage receives the source file, and the Cloud-capable action copies it to the 
cloud storage location you specified when you configured Cloud mode, placing the 
source file into a vcp-uploads folder. 

3. From the vcp-uploads folder, the Cloud-capable action processes the source file 
and places the output file in the cloud storage location.

4. Any actions downstream of the Cloud-capable action operate as they normally 
would do. These actions use the nickname to find the processed file in the Cloud 
and continue processing.

5. Use the Job Status tab to monitor processing status: Uploading (input to cloud 
storage), Queued, Processing, and Pushing (output to cloud storage). Note that 
actions cannot be paused, even though Vantage may indicate that you can do so.

Creating Hosted Workflows
This topic explains how to create and design hosted workflows in Workflow Designer. 
You deploy them to Telestream Cloud for execution independent of Vantage, using 
Telestream Cloud’s Vantage Cloud service. 

For details on uploading workflows to Telestream Cloud and managing their versions, 
see Managing Hosted Workflows. 

Note: You can also deploy hosted workflows to your account in Telestream cloud 
manually, as well. First, validate and export it from Vantage via Workflow Designer as a 
CWD file; next, you import it into Telestream Cloud.

Note: Before you can process media in Telestream Cloud, you must have set up your 
Telestream Cloud account, a third-party cloud storage account, and your Vantage 
domain settings for Vantage Cloud operation as explained previously. 

 Hosted Workflow Restrictions

 Creating a Prototype Hosted Workflow

Hosted Workflow Restrictions
A hosted workflow is one that is designed in Workflow Designer, validated and 
uploaded to Telestream Cloud for execution with no dependency on your Vantage 
domain. It is managed in the Telestream Cloud console. Often, jobs are submitted and 
also managed via a Vantage Cloud API-based program.

Hosted workflows differ from hybrid workflows in that they have a more restricted set 
of actions that are supported, and also have the following characteristics and limits:
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• Hosted workflows can only start with a Receive origin action.

• They must be able to execute successfully on-premises (in your Vantage domain). 
Testing on-premise requires that you change the location of output files, of course. 

• Use only Cloud-capable actions: 

– Cloud-capable transcoding actions must be configured to meet Vantage 
Telestream Cloud Service capabilities. See Using Vantage Cloud-capable Media 
Processing Actions.

– A limited set of utility actions that have been implemented in Telestream Cloud. 
See Using Vantage Cloud-capable General-Purpose Actions.

• You do not (should not, for consistency sake) enable Cloud mode on the transcod-
ing/media processing actions; the entire workflow (when imported) executes in 
Telestream Cloud and the Cloud mode settings must be configured directly in 
Telestream Cloud.

• All the same configuration limitations apply to Vantage Cloud-capable actions used 
in hybrid workflows. See Configuration Limitations in Cloud Mode.

• Hosted workflows can not include Cloud Speech | Location Telestream Cloud 
actions. Unsupported (and incorrectly-configured) actions are flagged when you 
upload your workflow.

• Actions (transcoders, for example) that generate files require you to configure the 
lifespan of the output file, because the workflow is executing outside the context of 
Vantage, which has automatic file lifespan management, whereas Telestream Cloud 
does not. 
When Telestream Cloud (not Vantage) is executing the workflow, a Delete action 
can’t be used to delete files created by action in the workflow. When Telestream 
Cloud executes workflow jobs, it uses the output lifespan setting to delete all tran-
sient files at the end of the workflow execution. (Lifespan settings are ignored when 
workflows execute locally, whether the Cloud-capable actions execute locally or in 
Telestream Cloud.)

– Transient—choose when the media created by this action is temporal—it is only 
used by other actions in this workflow, and should be automatically deleted 
immediately after the workflow (the job) has completed.

– Permanent—choose when the media should be retained (not deleted) after the 
workflow has completed. In this case, file management is beyond the scope of 
the workflow, Vantage, or Telestream Cloud.

• An action can’t generate multiple files with different Output Lifespan settings. For 
example, an IPTV/OVD action can’t generate one file which is Permanent and 
another which is Transient. If you require multiple outputs with different lifespans, 
add an action for each, and set this action’s output lifespan accordingly.
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Creating a Prototype Hosted Workflow
In this prototype, the Conform action ingests the CML file, performs the requisite 
transformation from CML and produces an intermediate version, passing it to IPTV Flip. 
Using the IPTV Flip action, a cable-compliant media version is generated as the target 
output. 

To create a hosted workflow, follow these steps, using this prototype as an example:

1. Open Workflow Designer and create a new workflow within the limits of Hosted 
Workflow Restrictions.

2. Add a Receive action (the only origin action permitted for hosted workflows) to 
start the workflow, and configure it with the nickname to use for accessing your 
source media version.

3. Add a Conform action and configure it.

The purpose of this workflow is to produce a Cable-compliant version of the media 
as defined by the incoming CML file, nicknamed Original. The generated output of 
the Conform action (nicknamed Transient) only has a useful lifespan within the con-
text of this workflow, as input to IPTV Flip. As such, the intermediary file Transient 
isn’t useful once this workflow job is complete. (A file with this temporal character-
istic is referred to as being transient.)

Contrast this to the generated output of the IPTV Flip action. This action emits an 
output file nicknamed Cable. This the version of the media that you intend to utilize 
in production for example, or have an indefinite lifespan beyond job execution. A 
file of this temporal characteristic is referred to as Permanent.



Designing Vantage Cloud Workflows
Creating Hosted Workflows

62 
4. Because this is a hosted workflow executing in Telestream Cloud, in order to delete 
the temporal file, right-click on the action and choose Cloud Mode > Output 
Lifespan. 

5. In the Output Lifespan dialog, select Transient and close the dialog.

6. Finally, add an IPTV Flip action and configure it. 

The purpose of this action is to produce a cable-compliant version of the media as 
defined by the incoming CML file, nicknamed Original. The generated output of the 
IPTV/VOD action (nicknamed Permanent) in contrast, has a useful lifespan within 
the context of this workflow, as input to IPTV Flip. 

7. Specify the Output Lifespan as Permanent.

Summary
This prototype is simplified to highlight the basics of Vantage Cloud hosted workflows. 
However, these workflows can be as complex as you require, including analysis, 
decision-making, and branching. 

You can include any action or number of actions upstream or downstream of Cloud-
capable actions. For example, you can use a Copy action to localize a transcoded file 
out of the Cloud, or use a Deploy action to send the file to another server or storage 
location. Because Vantage identifies file locations based on nicknames, subsequent 
actions only require nickname to identify, locate, and process cloud-resident files. 

Note: For a Vantage Cloud-capable action to execute successfully, the required 
accounts and credentials must be correct in all of these platforms and programs:

• Telestream Cloud—You must have a valid Vantage Cloud account, and you must 
include correct third-party storage credentials on the Data Store page.

• Third party cloud storage—You must have at least one valid cloud storage account. 

• Vantage Management Console > Settings & Options > Cloud—You must enter the 
name of your Telestream Cloud account and its API key.

• Vantage Management Console > Vantage Folder Address Book—You must enter 
the exact name and keys for your third-party cloud storage accounts.
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• Action-based Cloud mode—Select your Telestream Cloud account and your cloud 
storage account from the menus in the Vantage Cloud Setup dialog.

Verify your credentials carefully in all places. If credentials are entered incorrectly in any 
of these locations, Vantage Cloud may not function properly.

To review your cloud storage and Telestream Cloud configurations, see Creating a Cloud 
Storage Account and Creating a Telestream Cloud Account.

To review your Vantage settings, see Adding your Telestream Cloud Account to Vantage 
and Adding your Cloud Storage Account to the Vantage Folder Address Book for details.

Troubleshooting
The following tips may help you resolve issues with using Vantage Cloud features. If you 
cannot resolve a problem on your own, please contact Telestream Support for 
assistance (see Contacting Telestream).

Errors When Enabling Vantage Cloud Mode on an Action
If Vantage displays an error message when trying to select Cloud mode in a cloud-
capable action, the likely cause is that your Telestream Cloud account has not been 
entered in the Vantage Management Console > Settings & Options > Cloud tab. If you 
have entered the account, click the Test button to verify that your account credentials 
are correct and retry.

Connection Failures
An easy way to recognize if Vantage is connecting with Telestream Cloud and accessing 
third-party storage is that the white cloud logo and the green price indicator both 
display on the action. If Vantage fails to connect with Telestream Cloud or your cloud 
storage, as indicated by the absence of the logo and price on the action, check your 
credentials in every location where they are entered. 

Cloud-capable actions require credentials in all of these locations:

• Telestream Cloud

• Third party cloud storage

• Vantage Management Console > Settings & Options > Telestream Cloud

• Vantage Management Console > Vantage Folder Address Book

• Action-based Cloud mode > Vantage Cloud Setup selections.

Cloud and Storage Performance Considerations
If you have intermittent slow performance issues, consider these suggestions:

• Performance may vary by the type of storage resource you choose. 

• Network traffic during busy times of day may affect cloud and storage performance 
and transfer speeds.
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• Cloud storage can become temporarily unavailable. If Vantage Cloud can’t access 
your storage, visit your storage web site to determine whether your storage is inac-
cessible for some reason. Also be sure to verify your credentials.

• Default storage account settings often specify limits on various resources. If your 
workflows are exceeding these limits—requiring increased network speed or addi-
tional storage, update your account settings or contact your storage provider for 
assistance.
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Cloud Storage Is Overloaded by Uploads
The Vantage Telestream Cloud Service upload limit throttles concurrent uploads to 
prevent overloading cloud storage (default: 4 concurrent files). Use the Vantage 
Management Console > Services panel to select the service, put it into maintenance 
mode. Now, display the Cloud service Setup tab to access and change the Upload Limit 
value.

The total of this number for all nodes should be set to match the concurrent job limit 
set by Telestream Cloud (30 is the default).

Also, if a large file fails to upload automatically, try this workaround: Use a Copy action 
before the Vantage Cloud-capable action to manually copy the file to the Cloud.

Monitoring Job Status
You can manage hybrid workflow jobs in all of the same ways you normally would in 
Vantage. Use the Workflow Designer Job Status tab to get error messages and use the 
controls to Stop, Restart, or Delete jobs. 

You can also view job status in the Telestream Cloud dashboard. Log in and click the 
Dashboard > Vantage Cloud to see the hybrid jobs action list and hosted jobs list. Click 
on any job for details. Error messages in the status details will give you clues as to faulty 
workflow or action settings. 

Font Issues in Subtitles
Vantage Cloud-capable actions render fonts differently than actions executing on-
premise, because Cloud servers use Linux instead of Windows. Subtitles or other on-
screen print renderings that use the fonts built into on-premise Vantage OS may result 
in print output from the Cloud (Linux) that differs from the same output on Windows. In 
particular, font size, font spacing, font effects and anti-aliasing may have subtle 
differences between the two platforms. If you require a specific font style with Vantage 
Cloud, Telestream recommends waiting until NewBlue support is added to Linux.

Pausing Actions in Vantage Cloud Mode not Supported
Actions operating in Vantage Cloud mode can not be paused and will not respond to a 
Pause command.

Processing Time-Outs
Vantage Cloud-capable actions are optimized for execution efficiency in Telestream 
Cloud. However, if you have unusually large files or other factors that require heavy 
resource usage, it is possible that processing may time out after an extended time 
period. If this happens, please contact Telestream Support for assistance (see 
Contacting Telestream).

Reference and CML File Limits
If a reference or CML file that references more than 32 files is submitted to a Vantage 
Cloud-capable action, the job will fail at run time, indicating that this is not supported.
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Managing and Executing 
Workflows in Telestream 
Cloud
This chapter describes how to use the Telestream Cloud service via the Telestream 
Cloud web app to import workflows into Telestream Cloud and manage revisions. This 
chapter also describes how to submit jobs to hosted workflows, monitor cloud based 
actions and workflows, monitor analytics, and set up job notifications.

Note: Managing hosted workflows in Telestream Cloud is an alternative to managing 
hosted workflows directly in Vantage Workflow Designer, using its HostedWorkflow 
Manager (see Managing Hosted Workflows), with similar functionality and a more 
streamlined process.

While most of the tasks you need to perform to manage Cloud workflows are 
implemented in the Telestream Cloud web app, they are also implemented in the 
Telestream Cloud API, enabling you to implement Cloud workflow processing in your 
own systems or programs.

Note: Before you can process media in Telestream Cloud, you must have set up your 
Telestream Cloud account, a third-party cloud storage account, and your Vantage 
domain settings for cloud operation as explained in Getting Vantage Cloud Up and 
Running.

Topics
 Logging in to the Telestream Cloud Web App
 Importing New Workflows into Telestream Cloud
 Managing Hosted Workflow Revisions
 Submitting Jobs to a Hosted Workflow
 Monitoring and Managing Hosted Workflows and Jobs
 Monitoring and Managing Action Jobs
 Monitoring Financial Information
 Managing Notifications
 Troubleshooting
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Logging in to the Telestream Cloud Web App
To use the Telestream Cloud web app, open the Chrome web browser and log into your 
Telestream Cloud account to display the dashboard:

 

In the dashboard menu (blue, in the upper left corner), choose Vantage Cloud. Or, in the 
dashboard, locate the Vantage Cloud panel and click Go To Service.:

Click Go To Service to display the 
Vantage Cloud page. 

Telestream Cloud displays the Vantage Cloud page::

Use the menu (top left) to display each of the main panels where you perform all of 
your tasks related to Vantage Cloud.

https://cloud.telestream.net
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Importing New Workflows into Telestream Cloud
Deploying hosted workflows in Telestream cloud is a two-step process. First, you create 
and export the workflow from Vantage, via Workflow Designer (see Creating and 
Deploying Hosted Workflows). Next, you import it into Telestream Cloud, where it is 
referred to as a hosted workflow. The original workflow (which is not referred to as 
hosted) can continue to be utilized directly in Vantage as well, if required.

Note: Alternatively, consider using the HostedWorfklows Manager in Workflow 
Designer to upload hosted workflows and perform all other hosted workflow-related 
management tasks (see Managing Hosted Workflows).

Topics
 Creating a Hosted Workflow
 Hosted Workflow Tutorial

Note: This topic describes how to import new workflows—not workflows that already 
exist in Vantage Cloud and have been revised. When you revise an existing workflow 
and export the new version, if you were to import it using this method, it would be 
treated as a separate workflow—which may, in fact, be exactly what you want to do. 
However, if you want to associate the revision(s) with the original so that you can 
manage them collectively, you should import it as a revision. To learn how to import 
and manage workflow revisions, see Managing Hosted Workflow Revisions.

Creating a Hosted Workflow
To import a CWD workflow file, perform these steps:

1. In the Vantage Cloud Console, display the Workflows panel.

2. Click New Workflow.

3. Configure these fields (all are required):

Workflow Name (max. 255). Descriptive name for this workflow.

Workflow Document (max. 255). Enter the fully-qualified file path (in UNC | drive 
letter format) or browse to locate and choose the on-premises CWD file.

Default Store. Specifies the store where source media is located. Workflows 
exported from Workflow Designer for hosting in Telestream Cloud don’t include the 
storage location or subfolder, since they are independent of Telestream Cloud.

Stores are managed at the Telestream Cloud level. To view and manage stores, 
choose Manage Stores from the Telestream Cloud main menu.

Note: Optionally, specify a subfolder/folder offset and modify the default store. After 
creating a hosted workflow, you can modify the default store and add a subfolder 
offset: Click Workflows > (Target Workflow) > Details tab. Click the Gear icon for the 
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Store to update the default store. Click the Gear icon for the Folder Offset to specify an 
optional subfolder string.

4. When the file has been uploaded, click Create Workflow to validate it and activate it 
for use.
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Hosted Workflow Tutorial
This tutorial describes how to import CWD files that have been exported from Vantage 
Workflow Designer to an on-premises location on your network.

1. On the dashboard, choose Vantage Cloud Port from the menu to display the 
Vantage Cloud Port web app:

2. In the Vantage Cloud Port panel, choose Workflows to display the Workflows panel:

This panel displays workflows that have already been deployed, and enables you to 
add new ones to your account.
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3. Click New Workflow to display the New Workflow panel:

4. Configure the following fields (all are required):

Workflow Name (max. 255). Enter the descriptive, display name for this workflow. 
Workflow names must be unique within the Cloud Port service, but the name you 
enter does not have to match the name used in Vantage Workflow Designer. This 
name is displayed anywhere that this workflow or its jobs are referenced in the web 
app.

Workflow Document (max. 255). Manually enter the fully-qualified file path and 
name in Windows UNC or drive letter format, or click Browse to locate and choose 
the on-premises CWD file you exported from Workflow Designer. CWD files must be 
local or network accessible.

Default Store. Name of the store where source media for this workflow is located.

Note: If no stores are available, it indicates that no cloud storage locations have been 
defined in your Telestream Cloud account. You must add at least one cloud storage 
location in order to utilize hosted workflows. 
To create a new store, choose Add New Store. Select the platform for the store, 
configure it and click Add Store at the bottom of the panel.)

5. Next, click Create Workflow to upload it into Telestream Cloud.

Telestream Cloud uploads the file to the target store. Progress is indicated to the 
right of the Workflow Document field. 
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6. When uploading is complete, click Create Workflow to deploy it for use:

Telestream Cloud notifies you when deployment is complete and displays the new 
workflow in the Workflows table:

Summary
You’ve now completed the second half of the hosted workflow Design and Export / 
Import and Deploy process. Your hosted workflow is now ready to go to work!

Managing Hosted Workflow Revisions
During the life cycle of a workflow, modifications are often made to adapt it to 
changing requirements. Cloud Port supports workflow versioning; enabling you to 
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import multiple revisions of the same workflow, and activate a specific version at any 
point in time. The active version is always utilized when you interact with the workflow.

Note: Alternatively, consider using the HostedWorkflow Manager in Workflow 
Designer to upload hosted workflows and perform all other hosted workflow-related 
management tasks (see Managing Hosted Workflows).

This topic describes how to import modified workflows—workflows that have been 
modified and a new version exported from the Vantage domain. Telestream suggests 
importing updated workflows as a revision, so that they are directly associated with the 
original and you can manage the revisions effectively. Telestream does not recommend 
proliferating workflow revisions by the method described in Importing New Workflows 
into Telestream Cloud, as each revision would be a separate, independent workflow.

Using workflow revisions in Vantage Cloud may be very useful. However, Workflow 
Designer does not support revisions. Therefore, before revising a workflow for use in 
Vantage Cloud as a hosted workflow, best practice suggests that you duplicate the 
workflow in Workflow Designer and then make changes to the duplicated version, to 
maintain previous versions that are still deployed in Telestream Cloud.

Importing a Revised Workflow
To import a new version of an existing workflow, follow these steps:

1. Click Workflows and then choose the workflow you want to revise to display the 
workflow panel:
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2. Choose Add Revision from the menu (upper right corner):

Telestream Cloud displays the Add Revision dialog:

3. Click Browse to navigate to and choose the CWD file and import it as a version of 
the original workflow. Optionally, enter a comment to provide a description of the 
revised workflow:

4. When upload is complete, click Add to deploy the revised workflow.
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5. Click the Details tab to display all revisions of this workflow:

The Revisions table displays the new version Vantage Cloud just created. Click Make 
Default to make this the active revision. Use the Revision menu to display details about 
a given revision or set it to All to display all revisions of this workflow.

Here are the workflow revisions following the upload of a new revision:

In this example, the original (ID 1) version (uploaded on April 14th) is currently active.

The new (ID 2) version’s status is Staging to indicate that it is not currently in use.

Note: The comment entered when this revision was added explains what changed.
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Switching Between Workflow Revisions
When a workflow has multiple revisions, you can switch between them, making any 
revision active at any time. The active revision may have different variables and 
expected inputs that are used in the workflow.

Note: Alternatively, consider using the HostedWorkflow Manager in Workflow 
Designer to specify revisions of hosted workflows and perform all other hosted 
workflow-related management tasks (see Managing Hosted Workflows).

For example, when the original revision (Revision ID 1) is selected, the details of this 
workflow are displayed:

If you select the 2nd revision, then the new changes (for example, the newly added 
variable) display:
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The variable which was added to this version of the workflow is now displayed. Also note 
that the Make Default and Delete buttons are now enabled:

These controls are only enabled for revisions which are not currently active.

Make Default. This revision is made the default or active revision of the workflow.   Any 
API-based interaction with this workflow or any job submission via the Cloud Port web 
app will use this revision of the workflow, including expected variables and sources 
particular to this revision.

Delete. This workflow revision is permanently removed from Telestream Cloud.

Submitting Jobs to a Hosted Workflow
EDNOTE DO NOT DELETE/ALTER FileName marker: New Workflow panel context topic 
for ~/vantagecloudport/workflows/new. Access in TC > CP UX > Workflows > New 
Workflow. Filename: tc-cloudport-submit-job.htm.

To submit a job to a hosted workflow, follow these steps:

1. To submit a job to a hosted workflow, display the Workflows panel:

2. Choose the workflow to which you want to submit a job. 

Telestream Cloud displays the Workflow panel for the selected workflow:
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3. Click Submit Job to display the New Job panel, to configure the job requirements:

4. Configure these controls:

Job Name (optional). Enter a text string to display in the job list for this workflow. If 
blank, the job name is derived from the file name of the first source.

Variables. For each expected variable in your workflow, specify values for this job. 
(Using Variables and Parameters in Vantage Cloud Workflows).

Source. For each nickname in this workflow, manually enter or click Browse to 
choose a locally-stored file. Or, use a cloud storage browser utility to choose the 
Cloud-stored file and enter a Signed URL to access it. A Signed URL is a special URL 
which enables access to a file located in supported cloud storage (Google Cloud 
Storage | Amazon S3 | Azure BLOB Storage). 

The easiest way to obtain a signed URL is to use a network file utility to generate a 
signed URL for the file. For example, the AWS console.

Storage. Choose the storage (with a manually entered optional subfolder offset/
qualifier) for the output generated by any transcoding actions or other actions that 
require storage in this workflow.

Note: The Storage entry specification also defines the Provider and Region where this 
process should execute. See Creating a Cloud Storage Account for details.
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5. Click Submit Job to create a new job for this workflow and begin execution:

Now that you have submitted a job to this hosted workflow, you can monitor its 
progress in the Jobs Overview panel.

Reviewing Completed Hybrid Workflow Jobs
When the job completes, check Vantage Job Status for success or failure. If there is a 
failure, Vantage Job Status and your Telestream Cloud account provide details about 
what happened. 
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1. Finally, check the binder (right-click the job and select View Binder) and the cloud 
storage for expected output files (AWS S3 example shown). 

2. In Telestream Cloud, display the Vantage Cloud page.

3.  Click Overview to display the Jobs Overview panel and all action jobs.

4. Click the Workflow Name or Vantage Job Name to view job details for the target 
action.

5. Finally, check cloud storage for expected output files (AWS S3 example shown): 
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Monitoring and Managing Hosted Workflows and 
Jobs

EDNOTE DO NOT DELETE/ALTER FileName marker: Workflow Jobs Overview panel 
context topic for ~/vantagecloudport. Access in TC > CP UX by clicking Workflows in 
main menu. Filename: tc-cloudport-workflows-workflowjobs.htm.

Hosted workflows and their jobs are monitored in Telestream Cloud or via an API-based 
program. Jobs for hosted workflows are referred to as workflow jobs in the context of 
Telestream Cloud.

Topics
 Hosted Workflows

 Hosted Workflow Jobs

 Hosted Workflow Details

 Viewing Job Status

 Viewing Job Details

Hosted Workflows
To view and manage hosted workflows, click Vantage Cloud > Hosted Workflows to 
display its panel:

Click the New Workflow button to create a new workflow in Telestream Cloud, by 
uploading an exported CWD file from a Vantage domain. See Importing New Workflows 
into Telestream Cloud.

The Workflows panel displays a table of the workflows that have been deployed in 
Telestream Cloud. Workflows are listed by workflow name, and include the job ID, 
status, number of active jobs, and number of jobs in the last 30 days.

Use the workflows table to:

• Filter workflows—choose Active | Archived | All
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• Search for workflows—in the search field, enter workflow or action string.

• Monitor the number of active jobs—the value displayed represents the number of 
jobs concurrently running in this workflow.

• View workflow status—Invalid | Active | Staging | Archived. 

• Archive | Unarchive a workflow—click on the Down arrow icon associated with the 
workflow to archive it. Click on the Up arrow icon to unarchive it. When a workflow 
has been archived, you can not submit jobs to it or its active revision.

• Delete a workflow—click on the trash icon associated with the workflow entry to 
permanently remove it.

• Display workflow jobs and details—click on the workflow name to display jobs and 
details for the selected workflow. See Hosted Workflow Details.

Hosted Workflow Jobs
To display jobs associated with the selected workflow navigate to Vantage Cloud > 
Hosted Workflows and select a workflow and display its Jobs tab:

Click the Submit Job button to submit a file to a workflow in Telestream Cloud. See 
Submitting Jobs to a Hosted Workflow.

The Jobs tab displays a list of jobs associated with this workflow by job name, plus its 
status, cloud actions, and a time stamp.

You can use the table to:

• Search for jobs—in the search field, enter a string to search in the job name.

• Filter jobs—choose All | Created | Created | In Progress | Succeeded | Failed.

• Check cloud action status—during execution, click on the action name to display a 
progress bar.

• Delete a job—click on the trash icon associated with the job entry.
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• Display jobs and details—click on the job name. For information, see Hosted Work-
flow Details.

Hosted Workflow Details
EDNOTE DO NOT DELETE/ALTER FileName marker: Workflows Detail panel context 
topic for ~/vantagecloudport/workflows/<workflow UUID>. Access in TC > CP UX from 
the Workflows panel by clicking a specific job in table. Filename: tc-cloudport-
workflow-details.htm.

The Details tab displays the information for the selected workflows. To display a 
workflow’s details, click on the workflow name in the Workflows table. 

Telestream Cloud displays details similar to Vantage related to jobs it has processed.

To display workflow details, display the Details tab:

Click the Submit Job button to submit a file to a workflow in Telestream Cloud. See 
Submitting Jobs to a Hosted Workflow.

Metadata in the details pane applies to the workflow generally, and its revisions, if any.

Workflow ID. The workflow ID is used to identify and reference the workflow in all API 
operations. Click Copy to place the ID on the clipboard for use in API-based programs. 

Name. The display name of the workflow, assigned when the workflow was imported 
or when the job ran.

Vantage Workflow Name. Display name of the workflow in Vantage Workflow 
Designer.

Created at. Date/time stamp when the workflow was imported into Telestream Cloud.

Below the Jobs table, Telestream Cloud also provides other details by category: the 
default store, expected variables, sources, storage references, and a workflow graph. All 
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of this information is extracted from the Vantage workflow configuration, as depicted 
here in part:

Details Panel
The Details panel displays general information about the selected workflow.

It provides the workflow GUID, Telestream Cloud workflow name, Vantage workflow 
name, and date of upload/import.

Default Store Panel
The default store pane displays the store and subfolder/offset, if any, used by this 
workflow. You can also set the default store and folder offset here.

Click the Gear button to modify the default store and folder offset. Choose the store to 
use for actions in this workflow that generate files. (The cloud storage and subfolder 
path defined in Vantage for this workflow are not valid in Telestream Cloud and must 
be specified when you import a workflow (see Creating Hosted Workflows)).
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Expected Variables Panel
The Expected Variables panel displays the variables that are utilized in the workflow 
whose value is not provided by the workflow itself or by the variable’s default value.

ednote screen grab req’d

 Provide default values here. You can override them when you submit a job.

Sources Panel
Displays the sources defined in this workflow, by nickname and description.

 To change source definitions, edit the workflow in Workflow Designer and upload it as 
a new workflow or as a workflow revision.

Storage References Panel
Displays the actions in this workflow, by nickname and description with its life cycle, 
default store and folder offset.

For each action in the workflow, you can define a separate storage location and offset. 
Click the Gear button to change the default store and folder offset and save it for future 
jobs.



Managing and Executing Workflows in Telestream Cloud 
Monitoring and Managing Hosted Workflows and Jobs

89
Workflow Graph Panel
Displays the actions in this workflow as a graph, similar to its representation in 
Workflow Designer.

Each action in the workflow is identified by name and description. In this view, the 
graph actions are gray; it denotes the structure and organization of the workflow, 
independent of job execution.

Viewing Job Status
To display the status of a specific hosted workflow job, navigate to Vantage Cloud > 
Hosted Workflows. In the Hosted Workflows table, find the workflow you want, and 
click on its name link. In the Jobs tab, click on the job you’re interested in viewing—it 
displays the information for the selected job. This figure depicts the top portion:

EDNOTE DO NOT DELETE/ALTER FileName marker: Workflows Detail panel context 
topic for ~/vantagecloudport/workflows/<workflow UUID>. Access in TC > CP UX from 
the Workflows panel by clicking a specific job in table. Filename: tc-cloudport-
workflow-details.htm.

Telestream Cloud displays details similar to Vantage related to jobs it has processed.
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At the top, Telestream Cloud displays the submission date, total processing time, and 
approximate total cost.

The Action Job table displays a list of Telestream Cloud actions and their details: 
version, status, submission date, processing time, approximate cost, and number of 
outputs.

Click the disclosure button at the end of the action row to disclose input and output 
details.

For actions that failed, as depicted by the Analyze action in the preceding figure, 
Telestream Cloud reports an error that aids in troubleshooting. For example:

Resolve the error and retry the job.

Output Variables Panel
The Output Variables panel displays the variables that were utilized in the workflow.

Each variable is listed by name, with its post-execution value and the end of the job.

Workflow Graph Panel
Displays the actions in this workflow as a graph, similar to its representation in 
Workflow Designer. Post-execution states are color coded:

Each action in the workflow is identified by name and description. In this view, the blue 
actions executed with a SUCCESS state; red actions have a FAILED state; gray actions did 
not execute. 

For troubleshooting job failures, hover over the i button in each action that is not in a 
success state to learn details about this action’s execution.



Managing and Executing Workflows in Telestream Cloud 
Monitoring and Managing Hosted Workflows and Jobs

91
Cleanup Panel
Displays the tasks that were automatically executed by Telestream Cloud to delete 
temporary files from transient storage created during execution.

Each action in the workflow is identified by name and description. In this view, the 
graph actions are gray; it denotes the structure and organization of the workflow, 
independent of job execution.

Viewing Job Details
To display a job’s details, click on the workflow name in the Workflows table and then, 
click on the job you’re interested in viewing. Click the Details tab—it displays the 
information for the selected job in relevant panels.

Details Panel
The Details panel displays general information about the selected workflow.

Job ID. The Job ID is used to identify and reference the job in all API operations. Click 
Copy to copy the ID for use in API-based programs. 

Name. The display name of the workflow, assigned when the workflow was imported 
or when the job ran.

Vantage Workflow Name. Display name of the workflow in Vantage Workflow 
Designer.

Workflow Job Created at. Date/time stamp when the workflow executed the job.

Telestream Cloud also provides other details by category: the default store, expected 
variables, sources, storage references, and a workflow graph. All of this information is 
extracted from the Vantage workflow configuration, as depicted here in part:

It provides the workflow GUID, Telestream Cloud workflow name, Vantage workflow 
name, and date of upload/import.
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Variables Panel
The Variables panel displays the variables that are utilized in the workflow whose value 
is not provided by the workflow itself or by the variable’s default value.

 Provide default values here. You can override them when you submit a job.

Sources Panel
Displays the sources defined in this workflow, by nickname and file name as a URL.

 Click the link or copy icon to copy the URL for use in an API program.

Storage References Panel
Displays the actions in this workflow that utilized storage.

Each action’s store instance is identified by GUID with its store and folder offset.

Each action in the workflow is identified by name and description. In this view, the 
graph actions are gray; it denotes the structure and organization of the workflow, 
independent of job execution.

Renaming a Workflow
Renaming a workflow simply changes its display name. It has no other effect—its other 
copy, in your Vantage domain, retains the identical GUID.

To rename a workflow, follow these steps:

1. Click Workflows and then choose the workflow you want to revise. 

Telestream Cloud displays its workflow panel.
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2. In the Workflows menu, select Rename Workflow. 

3. In the Rename Workflow dialog, enter the new workflow’s name and click Save.

Archiving and Unarchiving Workflows
Archiving a hosted workflow renders it—or its active revision, in the case of a workflow 
with revision—unable to accept new jobs. 

Unarchiving a workflow returns it (or its active revision) to a normal state where it can 
accept jobs and execute.

Archiving a Workflow
To archive a workflow, follow these steps:

1. Click Workflows to display the Workflows panel.

2. Choose the workflow you want to archive. Telestream Cloud displays its panel.

3. In the Workflows menu, select Archive Workflow.

4. In the Rename Workflow dialog, enter the new name for this workflow and click 
Save.

5. When you archive a workflow, its panel is bannered with an Archive notice.

Unarchiving a Workflow
To unarchive a workflow, follow these steps:

1. Click Workflows to display the Workflows panel.

2. Show archived workflows to view only workflows that have been archived.

3. Choose the workflow you want to return to use. Telestream Cloud displays its panel.

4. In the Workflows menu, select Un-archive Workflow.

5. When you un-archive a workflow, the Archived banner is removed and the 
workflow can now execute jobs.

Deleting a Workflow
Deleting a workflow permanently removes it and all revisions from Telestream Cloud.

To delete a workflow, choose one:

Display the Workflows click the trash icon for workflow you want to delete, and confirm 
your decision in the dialog.

—OR— 

In the selected workflow’s panel choose Delete Workflow from the menu and confirm 
your decision in the dialog.

—OR— 

In Workflow Designer, display the HostedWorkflow Manager. In th Cloud Workflows 
table, select the workflow and click the Delete button (see Using the Cloud Workflows 
Panel).
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Exporting a Hosted Workflow
You can export a hosted workflow in CWD format; returning it to the same format 
exported by Vantage Workflow Designer. 

Among other purposes, you can use CWD files for:

• External archiving

• Transfer to other Telestream Cloud accounts

• Importing into Vantage.

Note: You can also download a hosted workflow directly into Vantage using 
Workflow Designer—see Downloading Workflows from Telestream Cloud.

Exporting a Hosted Workflow from Telestream Cloud
To export a hosted workflow using Telestream Cloud, follow these steps:

1. Click Workflows to display the Workflows panel.

2. Choose the workflow you want to export. Telestream Cloud displays its page.

3. In the Workflows menu, select Download CWD.

4. Chrome downloads the workflow file in Vantage CWD format as a JSON file and 
stores it in your Downloads location (Settings > Advanced > Downloads). When the 
process completes, displays an entry at the bottom of the window. Click on it to 
open the file or show it in its folder.

Monitoring and Managing Action Jobs
EDNOTE DO NOT DELETE/ALTER FileName marker: Jobs Overview panel context topic 
for ~/vantagecloudport. Access in TC > CP UX by clicking Overview in main menu. 
Filename: tc-cloudport-overview.htm.

Hybrid workflows that transfer actions to Telestream Cloud for execution are called 
action jobs in the context of Telestream Cloud. Action jobs can be monitored and 
managed in both Vantage and Telestream Cloud. In Vantage, you can focus on the 
workflow at the workflow level; in Telestream Cloud, you can focus on each Vantage 
Cloud-capable action that executed in Telestream Cloud. For information about 
monitoring jobs in Vantage, read the appropriate topics in the Vantage User’s Guide.

To view and manage action jobs—Vantage Cloud-capable actions—that have been 
submitted for execution in Telestream Cloud (from both hybrid and hosted workflows), 
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in the Dashboard, click go to service in the Vantage Cloud card to display the Job Status 
panel.

The Jobs Overview panel displays action jobs for all actions that are queued, running, 
or complete (in any state). If you have multiple Cloud-capable actions in a single 
workflow, Telestream Cloud displays a separate entry for each one in the workflow.

As jobs execute, the action status for each Cloud-capable action updates in real time.

The action table displays each action job’s Telestream Cloud workflow name, job name, 
the action itself, plus status and start date/time stamp. 

Note: The date/time stamp is in UTC; it displays the UTC value adjusted by the 
browser time zone value, based on the time zone set on your computer. If your 
computer timezone is set to auto-adjust, the displayed value will vary based on your 
location at the time of the inquiry.

You can use the action jobs table to:

• Search for actions—in the search field, enter the workflow or action string and the 
table updates automatically. Clear the field to return to the full list.

• Filter jobs—choose All | Created | In Progress | Completed

• Delete jobs—remove jobs that have completed; click on the trash icon associated 
with the job entry

• Cancel executing actions—click on the trash icon associated with the job entry

• Display action job details—click on the workflow name or Vantage job name to dis-
play the Job Details panel (Viewing Action Job Details).

Viewing Action Job Details
EDNOTE DO NOT DELETE/ALTER FileName marker: Jobs Details panel context topic for 
~/vantagecloudport/jobs/<jobUUID>. Access in TC > CP UX by clicking Overview > 
specific job in main menu. Filename: tc-cloudport-overview-actionjob-details.htm.
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Choose a job in the Jobs table to display the Job Details panel for this action:

The Job Details panel displays the following information:

Workflow Name. The Vantage name of the workflow that contains this action.

Job Name. The display name of the job that was submitted in Vantage for execution.

Started. The date/time stamp when the action began execution.

Output Store. The cloud location where the output is written to.

Inputs—Outputs. The number of input files and output files defined in this action.

Action. The Vantage name of this action, including the version number.

Processing Time. The elapsed time of execution.

Estimated Cost. The estimated cost of execution, in US dollars. The estimated cost is 
based on the duration of the output media and the features used in the action.

Job ID. The UUID assigned for this action job.

Note: Use the action job ID when utilizing this job via the API. You should also include 
the action job ID when a problem is being reported to Telestream Customer Service. 
Click the Copy icon to copy the job ID to the clipboard for use elsewhere.

Status. The status of the action:

Queued—Telestream Cloud is waiting for cloud resources on which to execute the job.

Downloading—The cloud server running the execution container is acquiring the 
source files required to start the job.

Processing—The job is being executed.
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Uploading—The output from the job is being uploaded back to your specified cloud 
storage location.

Successful—The job completed successfully.

Failed—The job encountered a problem during execution. See details of the job for 
error messages.

Inputs Tab
The Inputs tab lists each input file utilized by this action. The input is listed by 
nickname, and includes file size, duration, and link to a signed URL, which you can copy 
(click on the copy icon) for use in accessing this file.

If the signed URL is current, the link is the file name and you can click it to view the file. 
If the URL has expired, the filename is replaced by the nickname.

Output Tab
The Outputs tab conversely, lists each output file created by this action. The output is 
listed by nickname, and includes file size, duration, and URL, which you can copy (click 
on the copy icon) for use in accessing this file.

If the signed URL is current, the link is the file name and you can click it to view the file. 
If the URL has expired, the filename is replaced by the nickname.

Related Jobs
The Related Jobs tab displays other jobs that have the same Vantage job ID when the 
job was submitted. The jobs are listed by job name, and include the action and status.

Monitoring Financial Information
The Analytics panel provides you a financial breakdown of the cost of workflow 
processing by workflow and action. (Due to rounding of display values, the sum may 
vary slightly from the Total Cost entries.)

 

The Analytics table displays workflows and cloud actions, and the cost associated with 
its usage.
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On this panel you can:

• Change the Date Range—click in the Date Range field, then select the Period Begin 
date and the Period End date and click OK.

• Organize line items—click Show Filters; group them by Action | Filter | Domain ID.

• Organize line items—click Show Filters and filter them by Workflow Name | Action 
Name | Features Name | Domain ID.

The Feature value is the SKU of the Telestream Cloud component utilized. The 
Domain ID is the numeric identity of the Vantage domain from which the workflow 
originated.

Managing Notifications
Notifications enable Vantage Cloud—and other Telestream Cloud services—to send 
alerts when certain events occur. 

Note: Notifications can also be viewed and managed at the Telestream Cloud level by 
selecting Notifications from the main menu. The table displays notifications at this 
level for all services in Telestream Cloud.

 

The Notification panel displays a table of notifications that have been created. Each 
entry is listed by event, deliver method (type), and end point (for example, email 
address or URL).

On this panel you can:

• Create new notifications—click Add Notification to create a new one.

• View and update notification settings—click the Gear icon for the target notifica-
tion.

• Delete Notifications—click the trash icon of the target notification to permanently 
remove it.

Adding Notifications
To add a new notification, perform these steps:

1. To add a notification—on the Notifications panel, click Add Notification. 

2. On the Add Notification panel, complete these fields:
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• Service. Defaults to Vantage Cloud. 

• Store. Specifies which store (or all stores) this notification is intended for. (Stores 
are created and managed in Telestream Cloud via the main menu > Manage 
Stores).

• Delivery Method. Choose the delivery method: webhook | email | Amazon Simple 
Notification Service (SNS) | Azure Event Grid | Google Cloud Pub/Sub. 
Based on the delivery method, configure the notification to function as required.

• Available Events. Check one or more events to trigger the notification.

3. Click Create to save the notification you just configured and activate it.

Editing Notification Method Settings
Changes to an existing notification are limited to configuration settings of the specified 
delivery method—you can’t change the service, store, or delivery method.

To edit an existing notification, perform these steps:

1. On the Notifications panel, click the Gear icon for the target notification.for the 
target notification.

2. On the Add Notification panel, make changes to the delivery method’s 
configuration controls and field:

3. Click Save to update the notification and re-activate it.

Troubleshooting
The following tips may help you resolve issues with using Telestream Cloud features. If 
you cannot resolve a problem on your own, please contact Telestream Cloud Support 
for assistance (see Contacting Telestream).

Connection Failures
An easy way to recognize if Vantage is connecting with Telestream Cloud and accessing 
third-party storage is that the white cloud logo and the green price indicator both 
show up on the action. If Vantage fails to connect with Telestream Cloud or your cloud 
storage, as indicated by the absence of the logo and price on the action, check your 
credentials in every location where they are entered. 

For a Cloud-capable action to execute, the required credentials must be correct in all of 
these locations:

• Telestream Cloud

• Third party cloud storage

• Vantage Management Console > Settings & Options > Telestream Cloud

• Vantage Management Console > Vantage Folder Address Book

• Action Vantage Cloud mode > Vantage Cloud Setup selections.
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Cloud and Storage Performance Considerations
If you have intermittent or slow performance issues, consider these suggestions:

• Performance may vary by the type of storage resource you choose. 

• Network traffic during busy times of day may affect cloud and storage performance 
and transfer speeds.

• Cloud storage can become temporarily unavailable. If Telestream Cloud has trouble 
accessing your storage, visit your storage web site to determine whether your stor-
age is inaccessible for some reason. Also be sure to verify your credentials.

• Default storage account settings specify limits on various available resources. If you 
bump up against the limits and need greater speed or additional storage, contact 
your storage provider for assistance.



Managing and Executing Workflows in Telestream Cloud 
Troubleshooting

101
Cloud Storage Is Overloaded by Uploads
The Telestream Cloud Service in Vantage has an upload limit that throttles concurrent 
cloud file uploads to prevent overloading your cloud storage. The default is four 
concurrent files. 

To view or change the upload limit, follow these steps:

1. Open the Vantage Management Console.

2. Click Services in the Component panel on the left.

3. In the Services panel, select the Telestream Cloud Service and set it to maintenance 
mode.

4. Display the Setup tab below the table—change the Upload Limit value and click 
Apply.

5. Bring the Telestream Cloud Service back online.

If a large file fails to upload automatically, try this workaround: Use a Copy action before 
the Cloud-capable action to manually copy the file to the cloud before processing it.

Font Issues in Subtitles
Cloud-capable actions render fonts differently than actions executing on-premise, 
because cloud servers use Linux instead of Windows. Subtitles or other on-screen print 
renderings that use the fonts in the on-premise Vantage server may result in print 
output from the Cloud (Linux) that differs from the same output on Windows. 

In particular, font size, font spacing, font effects and anti-aliasing may have subtle 
differences between the two platforms. If you require a specific font style with Vantage 
Cloud, Telestream recommends waiting until NewBlue support is added to Linux.

Processing Time-Outs
Cloud-capable actions are optimized for execution efficiency in Telestream Cloud. 
However, if you have unusually large files or there are other factors that cause 
significant resource usage, it is possible that processing may time out after an extended 
period. A job that self-terminates displays an error message.

If this happens, contact Telestream Support for assistance (see Contacting Telestream).
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Managing Hosted 
Workflows
Web FileName marker in chapter title is VWD_HostedWorkflow_Manager. It is linked to 
the ? button in main HostedWorkflow Manager window/wizard

The HostedWorkflow Manager window enables you to manage your Vantage domain’s 
hosted workflows directly in Workflow Designer. Hosted workflows typically exist in 
two locations: your Vantage domain, and in your Telestream Cloud account. These two 
copies are one and the same workflow; they are associated with each other by their 
GUID.

Note: Use of HostedWorkflow Manager requires that you have a Telestream Cloud 
account and, in the Vantage Management Console, you’ve added the account API key.

Topics
■ Requirements

■ HostedWorkflow Manager Overview

■ Selecting Your Telestream Cloud Account & Store

■ Setting the Default Cloud Workflow Revision

■ Downloading Workflows from Vantage Cloud

■ Uploading New Workflow Revisions

■ Uploading Workflows to Vantage Cloud

■ Troubleshooting
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Requirements
Before you use HostedWorkflow Manager, be sure that you meet these requirements:

• You have a Telestream Cloud account.

If you don’t have a Telestream Cloud account, go to https://cloud.telestream.net/
console/signup and create one. If you already have an account and want to log in, 
go to https://cloud.telestream.net/console/login.

• In Vantage Cloud, create one or more stores where you want to save workflows.

• If user administration is enabled in your domain, your user must have Vantage 
Administrator privileges. (User administration is not required to develop hosted 
workflows.)

• You have created an account record in the Vantage Management Console. 

Go to Settings & Options and display the Cloud tab—create a record for the 
account and test it.

https://cloud.telestream.net/console/signup
https://cloud.telestream.net/console/signup
https://cloud.telestream.net/console/login
https://cloud.telestream.net/console/login
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HostedWorkflow Manager Overview
You can use the HostedWorkflow Manager window to manage your hosted workflows 
directly in Workflow Designer—create and upload them, or synchronize them in your 
Telestream Cloud account. You can also download hosted workflows from Vantage 
Cloud—for review, modification, and upload back to the cloud—directly in Workflow 
Designer.

Note: For basic information on using Vantage client programs, see Vantage Client 
Programs Overview.

Here is a depiction of the HostedWorkflow Manager window and its components:

Telestream Cloud 
account

Cloud Workflows 
toolbar

Cloud 
Workflows 
panel

Vantage 
Workflows 
panel

Vantage Workflows 
toolbar

Previous | 
Next and 
Close 
buttons

This window is comprised of two panels: Cloud Workflows and Vantage Workflows.
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Using the Cloud Workflows Panel
The Cloud Workflows panel displays all of the workflows in the selected Telestream 
Cloud account, with details.

Use this panel to operate on your workflows from the Cloud workflow perspective.

Toolbar Buttons for Cloud Workflow Operations
Select one or more workflows to operate on them, using the buttons in the toolbar. Or, 
right-click on a workflow and select these operations from the menu.

 Delete Cloud Workflow(s)—Permanently deletes the workflows from the store.

 Upload New Revision—When the workflow is out of date as indicated by the 
unsynchronized  icon, uploads the associated workflow to your 
Telestream Cloud account as a new revision. See Uploading New Workflow Revisions.

 Download Cloud Workflow(s)—For workflows that aren’t in your domain, copies 
the default revision of the selected workflow(s) to your domain. See Setting the Default 
Cloud Workflow Revision.

 Revision Management—When several revisions exist, allows you to change the 
default revision for execution. See Setting the Default Cloud Workflow Revision.

 Find Vantage Workflow—For workflows with a corresponding Vantage workflow 
(as noted by the  icon in the Exists Locally column), finds the corresponding 
workflow in the Vantage Workflows list and selects it.

 Refresh—Reloads the workflows from the default store; displays a progress bar 
during the operation.

Cloud Workflows Table Columns
You can sort each column in ascending | descending order.

Cloud Name—The display name of the hosted workflow in Vantage Cloud. Permits 
sorting ascending | descending.

Number of Revisions—The number of variations in this hosted workflow.

Default Revision—The revision of the workflow that is used when this workflow 
executes a job and when workflows are downloaded to a Vantage domain.
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Jobs in Last 30 Days—The number of jobs that have been executed by this workflow 
in the last 30 days.

Vantage Name—The name of the workflow in the Vantage domain when the workflow 
was first uploaded to Vantage Cloud. The name may have been changed in the Vantage 
domain after the upload occurred.

Note:  Telestream recommends that you use the same name for workflows that are 
hosted both in your domain and in Vantage Cloud.

Exists Locally—Specifies by a check mark that an associated workflow exists in your 
Vantage domain.

Exported Timestamp— The Exported Timestamp indicates the date/time that the 
selected Default Revision of the workflow was exported (uploaded) from the local 
Vantage domain.

Workflow Synchronized—For workflows with an associated Vantage workflow, 
indicates whether they are in synch or not.

Using the Vantage Workflows Panel
The Vantage Workflows panel displays all of the workflows that are in your domain, 
with details. 

Use this panel to operate on your workflows from the Vantage workflow perspective.

Toolbar Buttons for Vantage Workflow Operations
Select one or more workflows to operate on them, using the buttons in the toolbar. (Or, 
right-click on a workflow and select these operations from the menu.)

 Upload Vantage Workflow(s)—Uploads the workflow up to your Telestream 
Cloud account, using the name you specify. See Uploading Workflows to Vantage Cloud.

 Find Cloud Workflow—For workflows that have a corresponding Cloud workflow 
that was uploaded previously, finds and selects the corresponding workflow in the 
Cloud Workflows table.

 Refresh—Reloads the workflows from the default Telestream Cloud account.
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Vantage Workflows Table Columns
You can sort each column in ascending | descending order.

Vantage Name—The name of the associated workflow in your Vantage domain.

State—The designation of the state currently assigned the workflow.

Category—The Workflow Designer category that this workflow is stored in.

Description—The description of the workflow.
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Selecting Your Telestream Cloud Account & Store
To select or change the Telestream Cloud account and store that you want to use, 
follow these steps.

1. In Workflow Designer, select File > Vantage Cloud HostedWorkflow Manager
OR
Click the Cloud  icon in the Workflows panel title bar:

Cloud icon—displays the 
HostedWorkflow Manager

2. In the HostedWorkflow Manager window, click the Previous button at the bottom 
right corner. (The first time you display Hosted Workflows Manager, this panel 
displays first):

Workflow Designer displays the Account and Store dialog:

3. Select the account and store to use, and click Next to return to the main window.

Note: The store list is populated from your Telestream Cloud account. Make sure that 
your stores are valid, or that you are aware of which stores are valid. Your account may 
have stores whose buckets are no longer viable and is beyond control of Vantage.
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Setting the Default Cloud Workflow Revision
Web FileName marker VWD_HostedWorkflow_Revision_Management. use this for the 
Revision Management capability, it is linked to the ? button in the Revision 
Management dialog

For workflows with multiple versions in Vantage Cloud, the default revision is used for 
execution unless you override it during job submission. Usually, the default revision is 
the latest revision you’ve set; however, you can specify a different revision if you need 
to revert to a previous one.

Note: Vantage Cloud does not change the default (executable) revision without 
specific action. As a shortcut, when you upload a revision, you can set the new revision 
to the default (see Uploading New Workflow Revisions)—check Make this the default 
version in the Upload Revision dialog.
If you don’t change the default revision when you upload it, the revision remains the 
same until you change it in the Revision Management dialog. 

To change the default revision of a multi-revision workflow, display the Revision 
Management dialog:

Select the revision to set as the default revision and click OK.
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Downloading Workflows from Vantage Cloud
Web FileName marker: VWD_HostedWorkflow_Download. use for Download Workflow 
capability, it is linked to ?  button in the Download Workflow dialog

You can download workflows from Vantage Cloud to your Vantage domain if they 
haven’t previously been downloaded or when they don’t have an associated workflow 
already in the domain. 

Note: Workflow Designer downloads the revision currently-assigned as the default 
version. See Setting the Default Cloud Workflow Revision.

To download workflows, follow these steps:

1. Verify your Telestream Cloud account and store—click Previous; change the 
account and default store as required, then click Next to return to the main window.

2. In the Cloud Workflows panel, select one or more workflows to download.

3. Verify that they do not already exist in your domain, as indicated by the lack of a  
icon in the Exists Locally column.

4. Click the  Download Cloud Workflow(s) button | right-click on the Cloud 
workflow and select Download Cloud Workflow(s) to transfer the selected 
workflows to your domain. 

Workflow Designer displays this dialog for each workflow selected:

Workflow Designer uses the Cloud workflow’s name as the name to apply to the 
copy you create in your Vantage domain unless the workflow was given a different 
Cloud Workflow name when it was originally uploaded. In this situation, the down-
loaded copy of the workflow uses the original Vantage Workflow name, not the 
Vantage Cloud name. 

As an example, if you upload a workflow named My Workflow and give it the 
Cloud workflow name My Workflow (cloud), and then you delete the Vantage 
workflow (or connect to a different domain) when you download that workflow, 
the local Vantage copy is named My Workflow, not My Workflow (cloud).

5. Select the workflow category that you want Workflow Designer to store the 
workflow(s) in.
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Note: If the workflow (or any workflow, in a multiple workflow selection) already 
exists, Workflow Designer disables the Download button. Download is only permitted 
when there is no workflow in the local Vantage domain with the same ID GUID as the 
selected Cloud Workflow.

6. Click OK to proceed.

Workflow Designer displays a progress bar during the operation. When the transfer 
is complete, Workflow Designer updates the workflow record in the Cloud Work-

flows table: It displays a  icon in the Exists Locally column, and displays the syn-
chronized  icon to advise you that the two revisions are identical. 
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Uploading New Workflow Revisions
Web FileName marker: VWD_HostedWorkflow_Upload_Revision

When you modify a hosted workflow in Vantage, Workflow Designer flags its associated 
Cloud workflow with the unsynchronized  icon. 

Note: If the workflow (or any workflow, in a multiple workflow selection) already 
exists, Workflow Designer disables the Download button. Download is only permitted 
when there is no workflow in the local Vantage domain with the same ID GUID as the 
selected Cloud Workflow.

To upload the new revision that you’ve modified in Workflow Designer back to Vantage 
Cloud from your domain, follow these steps:

1. Verify your Telestream Cloud account and store—click Previous; change the 
account and default store as required, then click Next to return to the main window.

2. In the Cloud Workflows panel, select the unsynchronized workflow(s) and click the 
 Upload New Revision button 

OR
Right-click and select Upload New Revision to copy the workflow(s) to your 
Telestream Cloud account as new revisions.

Workflow Designer displays the Upload Revision dialog for each selected workflow:

3. Check Make this the default revision if you want to use this revision. If unchecked, 
the currently-specified revision remains unchanged unless you change it manually 
(see Setting the Default Cloud Workflow Revision).

4. Click OK to proceed.

5. Workflow Designer displays a progress dialog as it performs the operation, and 
updates the record in the Cloud Workflows table.
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Uploading Workflows to Vantage Cloud
Web FileName marker: VWD_HostedWorkflow_Upload. use this for the Upload 
Workflow capability, it is linked to the ? button in the Upload Workflow dialog

When you create a hosted workflow in Workflow Designer and validate it for execution 
in Vantage Cloud, you can upload it to your account and store for execution. 

Note: Telestream recommends that you use the same name for both copies of the 
workflow to avoid confusion. Even if you name them differently in Vantage and 
Vantage Cloud, they are in fact, the same workflow with the same GUID.

To upload Vantage workflows to Vantage Cloud, follow these steps:

1. Verify your Telestream Cloud account and store—click Previous; change the 
account and default store as required, then click Next to return to the main window.

2. In the Vantage Workflows panel, select the workflow(s) and click the  Upload 
Vantage Workflows button 
OR
Right-click and select Upload Vantage Workflow(s)... to copy the workflow(s) that 
you want to upload from your Vantage domain to your Telestream Cloud account 
as a new workflow. 

Note: Workflow Designer does not check for associated Cloud workflows. If the 
selected workflow(s) is in the account and store you’re working with, it displays an 
error, advising that this workflow is already associated with a Cloud workflow.

Workflow Designer displays the Upload Revision dialog for each selected workflow:

3. Enter the name for the Vantage Cloud copy or accept the default value: the same 
name. Telestream recommends using the same name in both Vantage and Cloud 
domains. These two copies are one and the same workflow, and they are associated 
with each other by their GUID; changing names can lead to confusion.

4. Click OK to proceed.

5. Workflow Designer uploads the new workflows, and displays a progress dialog as it 
performs the operation.

Note: If your workflow is not Vantage Cloud-compatible, Workflow Designer displays 
an error: “Unable to export workflow”. It provides information about what action or 
action’s configuration caused the error. Fix and retry.
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Troubleshooting
Use these topics to help solve problems you may encounter.

Problem: Workflow Designer displays an error—No Telestream Cloud credentials 
have been added to this domain when I attempt to open it. Or, Telestream Cloud 
account couldn’t be accessed. The API key may be incorrect.

Solution. You don’t have a Cloud account registered in Vantage or the account you 
entered is incorrect.

In the Management Console navigate to Settings & Options and display the Cloud Tab. 
Create a new Cloud account record using your Telestream Cloud credentials or update 
the account API key. Now, back in Workflow Designer, display the Hosted Workflows 
Manager window again.

If you don’t have a Telestream Cloud account, go to https://cloud.telestream.net/
console/signup and create one.

Problem: Workflow Designer displays a Does Not Exist error when I attempt to 
upload a workflow to a store:

Solution. You have selected a store whose bucket is no long valid. This list is populated 
from your Telestream Cloud account. Make sure that your stores are valid, or that you 
know which stores are valid. Your account may have stores whose bucket is not longer 
viable and is beyond control of Vantage.

https://cloud.telestream.net/console/signup
https://cloud.telestream.net/console/signup
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Workflow Designer displays an error when I tried to upload a workflow:

Solution. You have configured your workflow in a way that is not functional when 
executed in Vantage Cloud—thus, its not considered a valid cloud-hosted workflow. 
Read the error details, correct the configuration, and retry.
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